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Basic Interface 

 
NOTE: The interface shown above is for the Build desktop. It’s the default desktop. 
There are many different types of desktops you can switch between. 

 
Main Menu Main menu is always there and provides ways to access the basics. 

Unlike Maya, there doesn’t seem to be menusets available. These 
menus are constant. 

 
Desktop Desktops are essentially layouts. They’re similar to workspaces in Maya 

2017. The Build layout seems to be the default -- this is probably similar 



to the Maya Classic workspace. 

 
 
Radial Menu Radial menus are Houdini’s version of Maya’s marking menus. You can 

select what type of work you’re doing via this dropdown, and then press 
C in the viewport (and maybe other places as well?) to show up common 
features. 

 
 
Holding… 
 
X opens snapping functions 

 
 
C opens functions for what you selected in this dropdown 



 
 
V opens viewport functions 

 
 
HINT: You can also hit these keys instead of holding -- hitting will keep 
them open until you hit the key again. 

 
Shelves Similar to Maya shelves. Contains commonly used things. Note that 

unlike Maya, there are actually 2 shelf sets here. 
 
Scene View This is like Maya’s main viewport window. You can select objects, move 

them around, etc… 
 
HINT: The buttons right are the ones that’ll let you have multiple view 
ports and change your viewport views (e.g. enable shaded + wireframe). 

 
 
Parameter View This is like Maya’s channel view / attribute panel. You can manipulate 

attributes of whatever the it is you have selected in the viewport / 
network. 

 
Network View This is like Maya’s node editor. When you select something in here, it’ll 

also get selected in the viewport (and vice versa). 
 
Animation This is like Maya’s animation tools. 



Toolbar/Shelf Offscreen Icons 
If the Houdini window isn’t big enough, icons in the various toolbars/shelves may be missing. 
You can click the arrows or use the mouse scroll wheel (when hovered over the toolbar/shelf) to 
expose off screen buttons/icons in the toolbars and shelves. 

 

Toolbar/Shelf/Menu Manipulation 
On one side of a toolbar/shelf/menu, there should be a small black arrow that allows you to 
collapse or un-collapse that panel. 

 

Panel Manipulation 
Panels almost always are tabbed views -- meaning that a panel is made up of multiple tabs that 
you can flip through. Panels can be hidden, maximized, and shifted around via the dividers. The 
tabs within them can also be manipulated in various ways. 
 
Almost all panels have the following setup... 



 
 
The middle portion of the divider bar (the dotted portion) can be click+dragged to 
expand/contract the panel. You can also just click it (instead of click+drag) to swap the positions 
of the panels. 
 
The arrow buttons on the side of the middle portion can be clicked to have a panel take up all 
the space in that direction (hiding other panels). 
 
The top-right of a panel contains 3 buttons. 
 

1. The plus button allows you to add new tabs. 
2. The window button makes the panel take up the entire houdini window. 
3. The drop-down arrow gives you several other panel/tab manipulation options. 

 

Desktops 
Desktops are Houdini’s version of Maya’s workspaces. They’re essentially an arrangement of 
panels and windows that optimize a certain type of workflow. You can switch between desktops 
by using the desktop dropdown alongside the main menu… 



 

Reloading Desktops 
If you ever mess something up with your panels, or accidentally close certain panels and don’t 
know how to get them back, you can go to the desktop dropdown and select Reload Current 
Desktop. It’ll bring back all the panels and tabs and etc… in the way they were originally laid 
out. 

 

Saving Desktops 
If you’ve organized your layout to something that you’re comfortable with and you want to save 
it so you can use it later, you can use Save Current Desktop As. 
 
DO NOT USE Save Current Desktop because if you’re on one of the prebuilt desktops (e.g. 
Build) it will override the defaults and you won’t be able to go back to those defaults without 



blowing away all your preferences.. 

 

Projects 
Project’s are Houdini’s equivalent of Maya projects. A project is a set of organized folders on 
your harddrive that Houdini will look at to find different elements in your scene (e.g. textures). 
 
You can create a new project or load an existing project via the File menu… 

 

Contexts 
Houdini works in what are called “contexts”... Depending on the context you’re in, Houdini will 
provide you different operators/functions that you can use (these are exposed as nodes). 
 



There are many different contexts inside Houdini… 

 
● ch / chops 

Channel Operators 
- Used for manipulation of raw data (e.g. movement of objects) and some audio stuff. 

● img / cops 
Compositing Operators 
- Houdini offers an almost Nuke-like compositing package. All of that is container here. 

● obj 
??????????? 
- This is where your scene / shapes are generally described. 

● out / rops 
Rendering Operators 
- Allows you to set up various types of renders and exports. 

● shops 
Shading Operators 
- This is where you deal with most of your shading/material stuff. 

● vex / vops 
Vex Operators 
- Provides a node-based interface for doing programming and scripting. 

 
Some extra things to note… 

● Some contexts aren’t listed here. For example, if you’re working with particles, those are 
called pops (particle operators). Another one is dops: dynamic operators. 

● Certain contexts are independent of each other, while other contexts are crossed 
together (information can flow between them). 

 
Most views in Houdini that support switching between contexts (e.g. scene view) provide a 
common toolbar. 

 
 
Depending on the view that you’re in, you’ll be able to switch to different contexts. Some views 
may only support a subset of contexts (e.g. scene view), while others may support all contexts 
(e.g. network view). 
 



If you’re at the top-level, you can switch to contexts by left-clicking on the top breadcrumb… 

 
 
Another way to switch between contexts is to right-click on the top breadcrumb (doesn’t matter if 
you’re further down in the hierarchy) and go to Other Networks… 

 
 
The toolbar provides breadcrumbs that you can click on to quickly move back up the context 
hierarchy… 

 
 
And… just like a web browser, you can also use the back/forward buttons to move between 
your history of context switches… 

 

Scene View 
The scene view interface gives you a visual representation of your scene -- very similar to 
Maya’s viewports. 



 
NOTE: It’s best to turn off the reference grid and turn on the construction plane. The 
construction plane will constrain your Y to 0 when placing objects, unless you’re holding 
Shift. 

 
 
Selection Type Defines how you select. 

 

 
 
Button 1 is object selection. 
Button 2 is component selection (object must be selected first). 



Button 3 is ???? selection. 
 
You can right-click on each button to further refine selection parameters. 
For example, if you want to select by edge, you can right-click on button 
2 and specifically select edge as your component type. 

 
Manipulations Typical selection tools, very similar to the ones in Maya. The last one is 

called the “Handle” tool and it’s a combo of scale/rotate/translate. 
 

 
 
NOTE: The hotkeys here are different than the ones in Maya. Instead of 
QWER, it’s STRE... 
 
Select = S in Houdini Q in Maya 
Translate = T in Houdini W in Maya 
Rotate = R in Houdini T in Maya 
Scale = E in Houdini R in Maya 

 
Snapping Typical snapping controls, similar to the ones in Maya. 
 
Camera Control If you want exclusive control to manipulate the camera, select this. But, 

just like Maya, you can hold Alt+LMB/MMB/RMB to tumble/pan/zoom. 
You can also hold Space+LMB/MMB/RMB. 

 
Reference Plane The first button shows the construction plane. It’s good to have this on 

because when you’re dropping objects on the viewport they’ll be aligned 
to this plane. 
 
The second button shows the reference grid/plane. It looks like this is 
just a reference, probably doesn’t hurt to have this on. 
 

 



Multiple Viewports 
If you want multiple viewports in your scene view (just like you have in Maya), you can use the 
the viewport dropdown on the upper-right of the panel… 

 
 
The hotkeys are listed in the image. If you want to switch between single view and 4-panel view 
(just like in Maya), you can do so via Ctrl+1 and Ctrl+2. 

Viewport Orientation 
You can change the viewport camera through first dropdown in the upper-right the viewport… 

 
 
Just like Maya, top/front/right views are orthographic, meaning you won’t be able to tumble 
them. 
 
HINT: The hotkeys don’t work unless you’re holding Space. For example, Space+1 will take you 
to perspective. 



Creating Objects 
You can create objects either through the… 
 

1. create shelf 

 
HINT: Hold CTRL when clicking to have it show up at origin vs interactively placing it in 
the viewport 
 

2. tab menu 

 
 

3. radial menu (if radial menu is set to Main or Modeling) via Create 

 
 
When you’re asked to place in viewport (interactive placement), your placement will be bound to 
the construction plane. That means your Y will be fixed. You can hold Shift while you’re moving 
around to change the Y. 



Manipulating Objects and Components 
To move objects around in the scene, first change the selection mode to... 

 
Button 1 is object selection. 
Button 2 is component selection (object must be selected first). 
 

HINT: When you’re doing marquee selections, be mindful of the Select Visible Geometry 
Only option. When this is enabled, you’ll only select what you can see. So if you’re in 
shaded mode, everything hidden won’t be selected. But, if you’re in wireframe mode, 
nothing is hidden so everything will get selected. 
 
Note that THIS IS THE OPPOSITE OF HOW MAYA WORKS. Keep this off if you want 
consistent behaviour (it seems to be off by default). 

 
 
 

 
Then, select your manipulation tool and manipulate… 

 
The above will let you translate, rotate, and scale.The hotkeys for the manipulation tools are… 

● Translate = T 
● Rotate = R 
● Scale = E 
● Handle = Y (press twice to go to secondary mode) 

 
 



HINT: Hold Shift when dragging manipulation handles to make subtle change instead of 
normal change. 
 
HINT: If you want to interactively move the pivot point (the point around which you 
rotate), you can select any of the manipulation tools and hit the INS key.  

Selecting Components 
You can select components just like you do in Maya. 
 
Hold Ctrl and click to remove a selection. 
Hold Shift and click to add a selection. 
 
The basic tool for selection is the marquee tool (box picking). But there are several others. You 
can click-and-hold on the selection tool to get a flyout that’ll let you pick which tool you want to 
select with. 

 

Selecting Visible Geometry Only 
Regardless of which selection tool you use, be mindful of the Select Visible Geometry Only 
option. When this is enabled, you’ll only select what you can see. So if you’re in shaded mode, 
everything hidden won’t be selected. But, if you’re in wireframe mode, nothing is hidden so 
everything will get selected. 

 



Selecting by Group 
NOTE: Don’t know what groups are used for? Check out the Group nodes sectin for 
more information. 
 

In addition to both of these, you can view / highlight the various groups in the scene view by 
choosing the select tool and enabling enabling ‘Select Groups’ in the top toolbar… 

 
 
When you do this, a popup will show up on the lefthand side and you’ll only be able to select by 
groups. You can select groups as a whole by clicking on the actual model causing it to highlight 
in the popup pane (and vice versa). 
 
Selecting the diamond in the popup causes your models to get colorized by group, which is also 
super useful… 

 



Converting Selection between Component Types 
You can change your selection type (e.g. from edges to faces) by right-clicking on your selection 
and going to Convert Selection to… This is incredibly useful when you need to select geo in 
something that has lots of pits and grooves and other areas you can’t get into. For example, you 
can select edge loops that go totally around the object, and then convert that selection to faces. 

 

Growing/Expanding Selection 
You can grow a selection outwards by hitting Ctrl+G (or right-clicking on the selection and 
choosing Grow Selection). Note that the shortcut doesn’t always work -- I think if you move your 
mouse out of scene view and then back in, it won’t work anymore unless you make a new 
selection. 

 

Handle Alignment 
One thing to note is that, unlike Maya, the default here for the handles is to be object oriented 
rather than world oriented. That means that if you rotate your object and then try to translate, 
the handles will sync with the new orientation of the object. 
 
To fix this, hover over the handles and right-click. Then, go to Align Handle -> World… 



 

 
 
The above example shows the before and after. Note that in the after, the axis are aligned to the 
construction plane, which is aligned to the world. 

Handle Size 
If the handle is too small or large, you can use the * key to make it larger and the / key to make 
it smaller… 

 

Manipulating Camera 
You can manipulate the camera the same way you do in Maya… 

● Alt+LMB to tumble 
● Alt+MMB to pan 
● Alt+RMB to zoom 

 
NOTE: You can hold Space instead of Alt. It does the same thing. 

 
In addition to these hotkeys, you can click the camera button to exclusively use the mouse 
buttons to manipulate the camera. With the camera button selected, you don’t have to hold 
Alt/Space + relevant mouse button to tumble/pan/zoom (you can use the relevant mouse 



buttons by themselves). 

 
 

HINT: Using Alt is kind of a blessing and a curse. It helps you avoid having to develop 
new muscle memory after already learning how to do it in Maya, but certain important 
hotkeys won’t work in with Alt (they’ll only work with Space). 

Frame up on Selected Object 
To frame up on the selected object(s), either have the camera button selected and press F, or 
hit Space+F. 
 

NOTE: USING F BY ITSELF WON’T WORK. USING ALT+F WON’T WORK EITHER. If 
you want to use the the hotkey instead of the being in camera manipulation mode, you 
need to use Space+F. 

 
HINT: Space+G does this as well. Infact Space+G seems to be preferred instead of F 
because the network view also uses G to do the same thing. 

Frame up on All Objects 
To frame up on the all object(s), either have the camera button selected and press A, or hit 
Space+A. 
 

NOTE: USING A BY ITSELF WON’T WORK. USING ALT+A WON’T WORK EITHER. If 
you want to use the the hotkey instead of the being in camera manipulation mode, you 
need to use Space+A. 

Revert to Home Orientation 
To revert to the original camera orientation framed up on the construction plane, either have the 
camera button selected and press H, or hit Space+H. 
 

NOTE: USING H BY ITSELF WON’T WORK. USING ALT+H WON’T WORK EITHER. If 
you want to use the the hotkey instead of the being in camera manipulation mode, you 
need to use Space+H. 
 
NOTE: Remember that this frames up on the construction plane. If you have stuff 
outside of the construction plane, it won’t come into view. 



Changing Viewport Object Ghosting 
You can choose how objects appear based on your depth in the hierarchy by going to the 
ghosting type in the top-right of the viewport... 

 
 
For example, if you have Ghost Other Objects selected, when you dive into an object other 
objects will become semi-transparent. 

Changing Viewport Lighting/Shading 
You can choose how things are shaded by going to the shading type in the top-right of the 
viewport… 

 
 
You can choose how lights are shown by going to the right toolbar… 

 
Options are as follows (or you can just look directly at the tooltips to tell what’s what)... 



1. Disable lighting (flat shade?) 
2. Headlight only 
3. Normal lighting 
4. High-quality lighting 
5. High-quality lighting w/ shadows 
6. Display materials on objects 

Display Options 
You can change the particulars of how your scene is displayed (e.g. sampling quality) by doing 
to the very last button in the right-hand toolbar (you might need to scroll down to see it).... 

 
 
A lot of relevant options can be found under Scene and Effects. 

 
 
Scene will let you turn up AA samples and Effects will let you turn on special rendering options 
in the scene view (ambient occlusion, reflections, etc..). Depending on your workstation, your rig 



and the amount of geometry you have, Houdini may not be able to handle the settings you give 
it. 

Network View 
The network view interface gives you a node representation of your scene -- very similar to 
Maya’s node editor. Nodes feed into one another in a DAG. Each node represents some item or 
operations/functions performed on items. 

 
Selecting something in the network view will select it in all other views as well (e.g. scene 
view/parameter view/etc..). 
 

HINT: If you maximize this view, you can get the parameters panel to show up as a mini 
panel on the upper-right by pressing the P button (toggles on and off). 

 
HINT: You can show a tree view as a panel in the network view by pressing Shift+W. 
Note that the tree view is Houdini’s version of Maya’s outliner. 



Manipulating View 
The controls work similarly to the camera controls in the scene view, except you don’t need to 
hold the Alt/Space button and you can’t tumble because this is a 2D view. Hotkeys are as 
follows… 

● MMB pans 
● RMB zooms 
● H brings everything into view 
● G brings selection into view 

 
NOTE: Remember that LMB does nothing here. Neither does F (to frame up use G / to 
show all use H). 

Nodes 

Node Flags 
By flipping on/off flags in the network view. For example, if you have an object node... 

 
 

● Green edge toggles selectability in scene view. 
● Blue edge toggles visibility in scene view. 

 
Different node types give you different options. If you go within the object node, you’ll see more 
flags on a node… 
 

 
The flag edges, from left-to-right, are as follows… 

1. Bypass - Bypasses a node so that it doesn’t get evaluated in the node tree. 
2. Lock - ??? 
3. Template/Selectable Template - ??? 



4. Visibility - Whatever is being computed by the graph is visible in the scene view from this 
node. That is, if you have multiple nodes chained together, the one that has visibility 
turned on is the point at which it’ll show up in the scene view. Only one node in the chain 
can have this flag set. 

 
The radial menu options when you hover over the node pretty much do the same thing (they’re 
new to Houdini 16). The i button in the radial menu shows information about the node. 

Node Information 
You can get information on a node by click-and-holding MMB in the middle of the node (on the 
icon) to show a temporary popup… 

 
 
OR... by clicking the i in the radial menu to open a new window… 

 



 

Coloring Nodes 
You can assign custom colors to nodes. 
 
Select the nodes you want to color, then click the color palette toggle in the toolbar and choose 
the color you want. 

 

Positioning Nodes 
You can position nodes by clicking-and-dragging them around. 
 
The layout menu also provides lots of options for laying out your node, including functions you’ll 
find in most vector drawing programs (e.g. inkscape). For example, you can choose to show a 
grid and snap nodes to it while you move them around. 



  
 

NOTE: L is the auto-layout shortcut. If your node placement is messy, just hit L to 
organize it. 

Stepping Into Nodes 
You can step in and out of nodes in multiple ways… 

1. Double-click the node to step in. 
2. Click the node then hit Enter to go in. 
3. Click the node then hit I to go in / U to step out. 

 
You’ll also notice that as you step in, most views provide you with breadcrumbs that you can 
click on to quickly move back up the context hierarchy… 

 
 
Just like a web browser, you can also use the back/forward buttons to move between your 
history of context switches… 

 

Creating Netboxes 
A Houdini netbox is exactly the same thing as a Katana backdrop node. 
 



To use a netbox, select all the nodes you want to put inside of it and hit the netbox button in the 
toolbar… 

 →   
● Assign the netbox a name by double-clicking the title 
● Minimize the netbox using the upper left-hand corner 
● Color the netbox just as if you were coloring any other node 

 
When you … 

● move a netbox, it shifts everything inside of it with it. 
● delete a netbox, it only removes the netbox, not the stuff inside it 

 
NOTE: There is no J shortcut here like there is in Katana -- where you can jump to a 
backdrop node / netbox. Infact, netboxes don’t even show up in node searches (Ctrl+F in 
network view). 

Creating Notes 
You can create notes directly in Houdini. They show up as sticky notes, and you can move them 
around and manipulate them just like normal nodes. 
 
To create a note, click the note icon in the toolbar… 

 
 
A little yellow box will show up and you can click inside to fill it in. Click the minus sign in the 
upper right corner to collapse it. 

 



Creating Nodes 
You can create objects either through the tab menu. Either right-click to show the tab menu or 
hit tab, then select whatever it is you want to create... 

 

Parameter View 
The parameter view is the equivalent of Maya’s attribute editor. 



 
 
What’s displayed in here is entirely dependent on what you have selected. For example, if you 
have geometry selected, you’ll get something like the selection above: 
translate/rotate/scale/pivot/etc… 

Value Ladder 
If you’re making changes to numerical parameters, you can use the value ladder to make your 
adjustments. In the text box that takes in the input, hold down MMB. A scale should pop up. 

 



 
The number in the middle (0 in the example above) is the current value. Move your mouse 
pointer up/down to the scale you wish to adjust by, and move right to ADD and left to 
SUBTRACT. 

Setting Relative References 
Sometimes, you want to bind certain parameters to the parameters of some other node. For 
example, you may want your object to be centered around another object. 
 
To create a reference… 
 

1. Go to the parameter(s) to bind from and right-click and choose Copy Parameter… 

 
2. Go to the parameter(s) to bind to and right-click and choose Paste Relative 

References… 

 
 
When you do this, the parameters that you pasted to will turn green and they’ll reference a 
location. 
 
Notice what’s happening here. The parameter value changes to something like 
ch(“path1/path2”). The ch function lets you grab a parameter value from any node in your setup. 
You just need to specify the path. 



 
HINT: How do you know what the parameter name is? Go to the parameter and hover 
your mouse over the label. The tooltip that pops up will tell you… 

 
 
HINT: You can switch between seeing the references and seeing the evaluated values 
by clicking the field set name… 

 

 

Setting Dynamic References 
Just like relative references, you can do computations and stuff based on variables. Relative 
references are just a special case of that. 
 
For example, let’s say you want your X rotation to change based on what animation frame 
you’re currently at. You can reference the animation frame by using $F. 

 
 
Now let’s say you want to that rotation to speed up. You want it to go 2.5 times as fast. You can 
change that expression to be $F*2.5… 

 

Geometry Spreadsheet View (Attributes) 
Houdini allows you to set attributes on various levels of the geometry… 

● Object (also called detail) 
● Primitive (also called face) 
● Point 



● Vertex 
 
So for example, if you had a piece of geometry and you fed it into a color node, the output of 
that color node would be the same geometry with some added attributes… 

 

 
 
You can see in the properties panel shown above that we’re applying random colors to the 
vertices. If you go into the Geometry Spreadsheet panel (in the same tab set as the scene 
view), you’ll see a bunch of newly added attributes to the vertices that describe the color… 

 
NOTE: The toggle buttons in the toolbar let you switch between 
point/vertex/primitive(face)/detail(object) attributes. 

 
These attributes will propagate throughout your node network (and may potentially even be 
changed or removed by other nodes down the line). 
 

NOTE: These are lots and lots of common attribute types: colors, normals, uv, etc.... 
Check out the Common Attributes section of this page: 
http://www.sidefx.com/docs/houdini/model/attributes 

Manipulating Attributes / Moving Around Attributes 
Is your Merge node giving you a warning? Check the attributes of your inputs at various levels 
via the geometry spreadsheet. Just MMB click-and-hold over the node in Network View and 
you’ll see what attributes it’s passing through… 

http://www.sidefx.com/docs/houdini/model/attributes


 
 
Ultimately for a Merge node to not complain, all the attributes need to match up at the correct 
levels (e.g. if the UVs are on the vertex, then the UVs need to be on the vertex for all of the 
inputs).... 
 

● If you need to move around an attribute, use the Attribute Promote node 
● If you need to delete an attribute, use the Attribute Delete node 
● If you need to generate normals, use the Normal node 
● If you need to generate UVs, use the UV Unwrap node 

 
It’s super important to remember that the attributes MUST BE APPLIED AT THE SAME LEVEL. 
Having UVs for the 1st input on points while having them for the 2nd input on vertex IS A 
MISMATCH and needs to be corrected (use Attribute Promote for this). 
 
Note that some warnings may be okay. For example, you may have certain groupings (see 
section on Group nodes and/or materials) in one input but not the other. Groups are put in as 
attributes by Houdini. 

Scene Scale 
Scene scale is a super important concept when it comes to Houdini. The size of your objects 
has a direct effect on the way in which your simulations run. This is exactly like when you were 
using Box2D on Android. 
 
By default, Houdini is set to treat 1 unit as 1 meter in length / 1 kg in weight. You generally don’t 
want to change these values, but you can do so by going to Edit -> Preferences -> Hip File 
Options… 



 

 
 

NOTE: If you’re having problems visualizing this, think of a building collapsing. How long 
did it take the world trade center building to fall to the ground? Now imagine if the 
buildings were shrunken down to the height of a smartphone. 
 
In the new shrunken scale, the building would fall down much faster. The pieces falling 
to the ground would be much lighter. They wouldn’t be in the air as long. They’d have 
less impact when they hit the ground. They’d have less weight. etc.. 

Subnetworks 
Subnetworks are essentially groupings of nodes packaged together into a single node. 
 
To create a subnetwork… 

1. Go to the Network View 
2. Select the nodes you want to package up 



3. Go to Edit -> Collapse Selected Into Subnetwork 

 
 

HINT: Ctrl+A to select all 
 
All those nodes will now get put into a single node that you can double-click into… 

 

Custom Inputs / Parameters 
NOTE: Subnetworks will always have 4 baked in inputs. There’s no way to get rid of 
these or add more. The input connectors will always show up. But, you can add in 
custom parameters in the parameter view. See the following links for more info… 
http://forums.odforce.net/topic/23798-subnetwork-can-i-remove-inputs/ 
http://forums.odforce.net/topic/10387-more-than-4-inputs-in-a-subnet/ 

 
To create custom inputs for your subnetwork, begin by selecting the subnetwork in the network 
view. Then go into the parameter view, choose the gear, and select Edit Parameter Interface. 

 

http://forums.odforce.net/topic/23798-subnetwork-can-i-remove-inputs/
http://forums.odforce.net/topic/10387-more-than-4-inputs-in-a-subnet/


 
 
You’ll be presented with the Edit Parameter Interface dialog. 

 
 
The window is split into 3 sections… 

1. Create Parameters 
2. Existing Parameters 
3. Parameter Description. 

 
To create a new parameter, either drag-and-drop from 1 to 2 or select in one and hit the right 
arrow in between the two sections…. 

 
 
Once created, set a name and label in 3. You’ll see your new parameter show up in the 
Parameter View when you select… 



 
 

NOTE: If you want to move over existing parameters from one of the nodes inside the 
subnetwork, you can click the label of that parameter in the properties pane and drag it 
to root node in Existing Parameters. The Edit Parameters Interface isn’t a modal dialog 
box (you can still click around in the main Houdini window and do stuff even though the 
Edit Parameters Interface dialg is open and on top).... 

 
 
NOTE: You can stop the 4 baked inputs (e.g. Input #1 Label) from showing up in the 
parameter view if you choose them in the Edit Parameter Interface dialog and select to 
hide them. This only hides them in the parameter view… the input connectors on the 
subnetwork node will still be there. 

 

Custom Outputs 
By default, I think Houdini takes the first output of the first leaf node in the tree. If you want 
multiple outputs, you can drop output nodes in your subnetwork. Each output node will show up 
as a new output connector on your subnetwork… 

 



Exporting (Digital Assets) 
Houdini lets you export your subnetwork as a Houdini Digital Asset. When you do this, you can 
have it available for reuse in other houdini scenes that you work on / make it available for other 
artists by going to it in the Tab menu (it’ll be just like any of the other hardcoded nodes that 
Houdini provides). 
 
One of the other good things about Houdini Digital Assets are that you can load them up in 
other tools (e.g. Maya or Cinema 4D) via Houdini Engine and apply it to whatever it is you’re 
working on in those tools. 
 

NOTE: Houdini Engine doesn’t have an apprentice edition so I couldn’t try this out. But, 
the video showed how it worked with Maya. You just have to load the plugin and then a 
Houdini menu shows up in the main menu that you can use to load it up and assign stuff 
to the inputs/properties/etc... 

 
To export your subnetwork as a Houdini Digital Asset… 

1. Right-click it in the network view and select Create Digital Asset…

 
 

2. You’ll be presented with a dialog to provide a name+label+location to save in and hit 
Accept… 

 



Operator Name → what shows up in the tab menu 
Operator Label → the default name once placed 
Save to Library → disk location to save to 
 
NOTE: By default the save location will be the otls subdirectory of your main Houdini 
preferences folder. If you choose this, it’ll be made available to any project you work on. 
If you only want to make it available to scenes in your current project, you can put it in 
the hda subdirectory of your current project directory ($HIP/hda/my_node.hdanc). 
 
NOTE: otls stands for Operator Type LibrarieS. 
 

3. You’ll be presented with a dialog t o provide the operator properties… 

 
There are lots of options here, but the most tabs are… 

a. Basic should be pretty straight forward. 
b. Help is just a textbox where you document what your node does. 
c. Tools is where you can set what Sub-menu of the Tab menu your Digital Asset 

pops-up under --  TAB Submenu Path under the Context tab. 

 
d. Input/Output is where you can set the name/label of the input and output 

connectors on your node. 



Importing/Exporting Assets 
You can import/export assets through the file menu… 

 
 
If you’re importing assets, make sure that you place your assets inside of your project folder in 
the CORRECT subfolder. For example, all imported geometry should sit in /geo. It looks like the 
import isn’t a one-time thing -- the file being imported is referenced continually. 

Correcting Imported Geometry 
When you’re importing geometry, the dimensions of the object may not be what they are in the 
real world -- meaning that your simulations will come out wrong. If you want to resize your 
imported geometry to the correct dimensions (assuming you know what those dimensions are)... 
 

1. Go into the imported model’s node. 
2. Normalize the center/translate/whatever with a transform node (if required). 
3. Add a box node -- size it to the correct size. 
4. Add a match size node -- feed in the model and the box. 



 

 

Component Selection and Manipulation 
You need to be in the scene view to do this. Note that any modifications on components are 
added to your network as an Edit  node. 

 
 

HINT: For all selections (even when you’re doing marquee selections). Hold Shift to add 
to your existing selection / Ctrl to remove from existing selections. The mouse cursor 
should change to show a mini + or - symbol. 
 
NOTE: There’s more on selections in the Scene view notes above. 

Selecting Primitives (Faces) 
1. Select object selection button 
2. Select your object 
3. Right-click component selection button (or left-click and hold) 
4. Choose Primitives in the pop-up 



 
 

● Click to select a face 

 
● Click to select a face + hold A and select another face to select a path of faces 

 
● Double-click to select all faces 

 

Selecting Edges 
1. Select object selection button 
2. Select your object 
3. Right-click component selection button (or left-click and hold) 
4. Choose Edges in the pop-up 



 
 

● Click to select an edge 

 
● Click to select an edge + hold A and select another edge to select a path of edges 

 
● Double-click to select an edge loop 

 

Selecting Points 
HINT: A point is simply a point in space as defined by four numbers (X, Y, Z, W). A 
vertex is a reference to a point. Points are what you want, even though you may think 
of them as vertices. 
 

1. Select object selection button 
2. Select your object 
3. Right-click component selection button (or left-click and hold) 
4. Choose Points in the pop-up 



 
 

● Click to select a point 

 
● Click to select a point + hold A and select another point to select a path of points 

 
● Double-click to select all points 

 

Converting between Primitive/Edge/Point Selections 
1. Make your component selection 
2. Right-click anywhere in the viewport 
3. Choose Convert Selection to -> (component type here) 

 



 

Scale/Rotate/Translate Tools 
The scale/rotate/translate tools work the way they normally do. Select via the left toolbar… 

 
 
Or, use the hotkeys… 

● E = Scale 
● R = Rotate 
● T = Translate 

 
When you’re in component mode (instead of object mode), you can select what mode your 
manipulation tool uses via the top toolbar… 

 
 

1. Edit mode -- The typical mode (this is what you expect to happen) 
2. Slide on surface -- The change is constrained to the surface made up by the surrounding 

area. Use this to try to retain the shape of your geo. 
3. Peak -- Unsure what this does??? The opposite of slide on surface? It just protrudes? 



4. Sculpt -- Sculpts. You can choose brush size, etc… I don’t know the exact details of this. 

Group Nodes 
Groups are a way to bundle up geometry components together for whatever reason. Most of the 
time we want to do this bundling because we want to apply materials to specific parts of the 
geometry. For example, if you had a mesh of a car, you would want a separate material applied 
to the glass vs the rest of the car body. 
 

NOTE: You can use groups in pretty much any node that asks you for a group, or you 
can manually select the components to apply to. Creating a group makes things more 
organized, and the group created can be used in multiple places using the same 
reference.  
 
It’s like using a constant in your code (private static final int DEFAULT_VALUE = 5) vs 
using a literal (5). 

 
You can create and modify groups with the various Group nodes. Most of these are 
self-explanatory, and the important ones are detailed in the subsection below. 

 
 
Once your group is available, you’ll be able to see it in the geometry spreadsheet as an 
attribute. If the component is included in the group, you’ll see a 1 for the attribute that that group 
is for. Otherwise you’ll see a 0. 



 
 
You’ll also able to see the group (along with other groups propagated down) by MMB 
click-and-holding the node in the network view (or by clicking the information radial button -- 
does the same thing)... 

 
 
In addition to both of these, you can view / highlight the various groups in the scene view by 
choosing the select tool and enabling enabling ‘Select Groups’ in the top toolbar… 

 
 
When you do this, a popup will show up on the lefthand side and you’ll only be able to select by 
groups. You can select groups as a whole by clicking on the actual model causing it to highlight 



in the popup pane (and vice versa). 
 
Selecting the diamond in the popup causes your models to get colorized by group, which is also 
super useful… 

 

Group (Create component groups) 
You can group up primitives(faces)/edges/points together for various operations down the line. 
For example, you can apply different materials to the various groups in your geometry. 
 
Begin by selecting a the components you want to group together, and then dumping in a Group 
node and hooking it up to your geo. Doesn’t matter where you do it. 

 
 
Alternatively, you can make your selection after dumping in the node. Go into the properties 
pane and click the left arrow next to Base Group. Follow the prompts that show up in the Scene 
view. 

 
 



Notice that you can also set the group type here as well (e.g. do you want to group edges or 
points or primitives(faces)).  
 

NOTE: If you select nothing for the group, the entire geometry will be included in the 
group. 
 
NOTE: There are lots of different ways to group stuff by in the properties pane: keep by 
normals/edges/etc… I don’t know what all of these actually do, but I think manually 
selecting the faces is the main way this node is used. 

 
HINT: It’s good to give your groups descriptive names. For example the name 
mat_tire_rubber_group makes it pretty obvious what this group is for: it’s the polys that 
the tire rubber material should be applied to. 

Group Combine 
one super important one is Group Combine. Group Combine lets you create groups based on 
simple math expressions where the operands are other groups that are being propagated down 
the chain. 
 
One important use case for this is if you want to take all remaining geometry (geo that isn’t part 
of a group) and stick it into some final group. Here’s what the properties dialog looks like… 

 
It’s basically saying that this group (mat_chrome_group) is equal to everything that isn’t in 
(Equals All But) all previous groups (mat_brake_drum_group and mat_tire_rubber_group -- 
notice how they both have asterisks at the end, that means that they’re both selected). 

Creating Geometry 
Polygon modeling can be done via the Create and Polygon nodes. You can get to these by 
either going to the Tab menu (at root /obj level) or via the Create/Polygon shelf. 



 

 

 

Interactive Modeling (Scene View) 
If you prefer to use the Scene view to do your modelling, it is highly recommended that you use 
the shelf. Adding nodes via the shelf will interactively prompts you to put in the inputs rather 
than putting inputs via the parameter’s view. 

 



Non-Interactive Modeling (Network View) 
If you prefer to use the Network graph view to do your modelling, you can still select which 
components you want the operations to affect in the scene view. All you have to do is go to the 
parameter view of the node and find where your component inputs should go (e.g. faces) and 
click the arrow button to the left… 

 
NOTE: Some tools won’t have this. For example, trying to specify edge loops through 
the parameter window would be a nightmare -- use the shelf to interactively place those 
instead. 
 
NOTE: If you see that the input is a group, you can use pre-determined groups. See the 
Group Nodes section for more information. 

Creating Primitives 
To create a primitive, you can use the Create shelf or go to Create in the Tab menu 

 

 
 
Common things you might want to create (because you’re doing box modeling type stuff) is… 

● Box 
● Sphere 
● Tube 
● Torus 



● Grid ← this is shorthand for plane 
● Circle 

 
Another cool thing you can do is put in text as polygons -- you can then do normal polygon 
operations on this text: extrude, etc.. etc.. 
 
A lot of times, when you create a primitive, you’ll need to orient it (move, scale, change the pivot 
point, rotate, etc..). You can do this through a transform node, but most of the time the primitive 
itself will give you the ability to orient it. For example, a circle node has the following orientation 
options built-in… 

 

Importing Geometry 
All of the primitives discussed in the previous section are created inside of a Geometry node. So 
for example, you can ask to create a Box in the scene view, but what that actually does is create 
a Geometry node called Box and shoves a Box node in there. If you traverse into that Geometry 
node, you’ll actually see the inner Box node that creates the actual box geo. 

 →   
 
In the same vein, if you want to import some geometry, you can dump a basic Geometry node 
and add import nodes in there instead of nodes to create some primitive. To do so… 



1. In the scene view, open the tab menu and search for Geometry (you can find this at the 
top /obj level in the network view as well -- tab menu).

 
2. Navigate into the new Geometry node. 
3. Open the tab menu again (in the network view) and go under the Import section.

 
 
Many of the import options should be self-explanatory… 

● Alembic probably imports alembic files 
● File brings in files like OBJ 
● Object Merge lets you copy over specify geometry from somewhere else in your scene 

(you have to give it a path) 
● Table Import probably lets you shove in some python code or something 



Geometry Nodes 
These nodes are for when you go into a geometry node. For example, if you create a Box in 
your scene view, but what that actually does is create a new geometry node and shoves a box 
in there. 
 
These nodes will ONLY be available when you traverse into the geometry node! 

PolyExtrude (Extrude faces/edge) 
The PolyExtrude tool extrudes polygon(s). To get to the PolyExtrude tool, you can use the the 
Tab menu or the Polygon shelf. 

 

 
 

NOTE: Do not choose the other Extrude tools by accident. Those tools are totally 
different from the PolyExtrude tool. 

 
 
 
If you’re working in interactive mode (via the scene view and Polygon shelf) you can extrude 
your polygons by… 



1. Choosing the components (e.g. faces) you want to extrude 

 
2. Clicking the PolyExtrude tool in the shelf 

 
3. Dragging the handle and/or sliders that show up 

 

 
 
 
If you’re working in non-interactive mode (via the network view) you can extrude polygons by 
connecting your geometry to the first input of a PolyExtrude node… 

 
NOTE: The second input is for curving the extrusion. See the Spine Shape section 
below. 
 
HINT: A lot of times you want to extrude something multiple times quickly. If the last 
node in your networks graph is a extrude node (e.g. you just finished extruding 
something) and you want to follow up with another extrusion, hover your mouse in the 
scene view and press Q. The Q shortcut just adds in another node of the same type 
again. Just make sure you have the correct components still selected before pressing it. 
 

 
Regardless of how you did things, the properties panel will give you a bunch of settings that’ll let 
you change how the extrusion works… 



 
 
Here’s an outline of what each of these means… 
 
Group Components being extruded. 

 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 
 
If empty, it extrudes everything. 

 
Divide Into If you want your extrusion to affect the selected components as a 

whole… 

 
 
Exclusion Mode ??? 
 
Distance How far to extrude. 
 
Inset How much to expand/contract extruded the components. 

 
 



Twist How much to twist the extrusion by. 

 
 
Division How many division the extrusion should have. 

 
 
Spine Shape Controls how the extrusion curves. Depending on the option you choose, 

this can either be… 
 
* straight (linear) 
* curved (you define properties of the curve in the spline tab) 
* curved from 2nd input (you feed in a NURBs curve into the 2nd input of 
the node) 
 
NOTE: This seems to be very similar to Maya’s extrusion. 

 
Transform Extruded If you choose this, you’ll be presented with transform options just below 

your selection. With this option, you’ll be able to transform the faces that 
you extruded out (e.g. translate/rotate/scale). 

 
In addition to the options shown above, if you go to the Spine Control tab, you have the ability to 
change the thickness of the extrusion at various points + change the twist at various points. Just 
make sure that you have enough divisions in your extrusion.  

 



PolyFill / PolyCap (Fill holes) 
The PolyFill tool (called PolyCap in Houdini 15) lets you create faces between edges in your 
geometry. So if you have a hole in your geometry, you can use the PolyFill tool to create face(s) 
to fill in that hole. 
 
 
If you’re working in interactive mode (via the scene view and Polygon shelf) you can extrude 
your polygons by… 

1. Selecting the edges you want filled in 

 
2. Clicking the PolyFill tool in the shelf 

 

 
 
 
 
If you’re working in non-interactive mode (via the network view) you can fill by connecting your 
geometry to the input of a PolyFill node… 

 
 
 



Regardless of how you did things, the properties panel will give you a bunch of settings that’ll let 
you change how the fill works… 

 
 
Boundary Group The edges to create the fill between. 

 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 
 
If empty, it tries to fill every ‘gap’ that it finds. 

 
Fill Mode Defines the type of polygon(s) to use for the fill. Options include… 

 

 
 
NOTE: Single Polygon means that only 1 polygon will be used. That 
means that all points on the selected edges have to exist on the same 
plane. If that isn’t the case, it seems like it implicitly chooses the 
Triangles option, but none of edges for the generated faces will be 
selectable. 

 
Auto-Complete Boun If your boundary only contains only part of a hole, this option tries to get 

the edges for the rest of the hole. 
 
Reverse Patches Reverses the orientation of the created polygons. Orientation in this case 

means what??? It looks like it just creates the polys in reverse order. 
 



Unique Points The generated polygons won’t share their points with edges that they 
were created against. Meaning that technically this won’t be a solid piece 
of geometry? It’ll technically be 2 pieces? 

 
Update Point Norma The normals of the points that are getting filled will be updated to include 

the new faces? 
 
Edge Loop Seems to add an extra edge around the geo that is created??? 
 
Smooth Seems to shift around how the fill geo that is created??? 

PolyBridge (Bridge between edges) 
The PolyBridge tool lets you create a bridge between 2 sets of edges. 

 
 
 
To interactively create a bridge (via scene view)... 

1. Select the PolyBridge tool from the shelf 

 
2. Select the source edges and press enter (you’ll be prompted to do so in the scene view) 
3. Select the dest edges and press enter (you’ll be prompted to do so in the scene view) 

 
 
To non-interactively create a bridge (via network view)... 

1. Drop a PolyBridge node and connect your geometry to the first input 
2. In the properties panel, under the Footing tab, fill in Source -> Group 
3. In the properties panel, under the Footing tab, fill in Destination -> Group 

 
 

NOTE: The second input is for an external curve… if you want your bridge to follow 
some external curve. 
 



NOTE: If you notice that the bridge is messed up upon creation (e.g. inside out), try 
clicking the Reverse Winding options (there’s 2 of these, one for source and one for 
destination). If that doesn’t work, try fiddling with the Default Pairing Shift slider option. 

 
 
Regardless of how you did things, the properties panel will give you a bunch of settings that’ll let 
you change how the bridge works… 

 
 
Divisions The number of divisions you want your bridge to have. 
 
Spine Shape Controls how the bridge curve. Depending on the option you choose, this 

can either be… 
 
* straight (linear) 
* curved (you define properties of the curve in the spine tab) 
* curved from 2nd input (you feed in a NURBs curve into the 2nd input of 
the node) 
 
NOTE: This seems to be very similar to Maya’s extrusion. 

 
Default Pairing Shift Shifts the mapping of the source edges to the destination edges. Change 

this if your bridge is coming out twisted. 

 
 
 
The Footing tab in the properties controls the source and destination from which the bridge is 
created. It’s split into 2 sections: Source and Destination. The same options are available for 
both. 



 
 
Group The source/destination edges for the bridge. 

 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 
 
If empty, does nothing. 

 
Divide Into If set to Connected Components, the bridge will be a solid piece. 

If set to Individual Components, the bridge will be a exploded by edge. 

 
 
Reverse Winding Try this if the bridge is coming out twisted or out of place. 
 



Depart/Arrive Controls the direction that the bridge this starts/stops from. 

 
 
Magnitude Blasts out (scales) the bridge from the source/destination position. 

 
 
Stiffness How stiff the bridge is from the source/destination position. 

 
 
 



The Spine tab in the properties controls the spine of the bridge that is created. 

 
 
Source Divisions Adds divisions “to the start of the bridge.” I don’t know how this works, 

the divisions don’t seem to be bound the the start or the end. 
 
Destination Divisions Adds divisions “to the end of the bridge.” I don’t know how this works, the 

divisions don’t seem to be bound the the start or the end. 
 
Spacing There are 2 options here... 

 
* uniform 
* curve sensitive 
 
Curve sensitive is almost always the one you want. It adds in the 
divisions where the curve starts to twist and turn (where it needs more 



divisions). If you choose uniform it’ll add it evenly. 

 
 
 



The Bridge tab controls how the actual bridge gets created 

 
 
Clip Start/End Clips the start/end of the bridge. That means that if this isn’t 0, you’ll see 

a gap at the start/end of your bridge. 



 
Normals If normals should be added for your bridge??? 
 
Delete Primitives Delete the faces/edges which these bridges were generated from??? 
 
Thickness How thick you want to be the bridge. You can change thickness in 

multiple places. 

 
 
Twist How you want your bridge to twist. You can change the twist in multiple 

places. 

 

Edge Loop 
You can create an edge loop by going to the shelf and selecting Edge Loop… 

 
 
Or by dropping a PolySplit node in the network view and hooking your geometry into it… 

 
 
 
Regardless of how you do it, you’ll be prompted to select where you want the edge loop created 
in your scene view. You’ll notice that as you move your mouse around your geo, it’ll hover a 
yellow loop around where you’re aiming at… 



 
 
Click once to create the loop. If you need to adjust, go into the properties… 

 
 
Split Locations The number after the colon is where the edge will get created. Use this if 

you want to make tiny tweaks. 
 
Number of Loops If this is set to > 0, the number in split location (the one after the colon) is 

ignored and instead n new edge loops are created equidistant from each 
other. 

 
 



UNLESS Match Profile (just below Number of Loops) is checked. Then 
it’ll create the equidistant loops starting from the split location. 

 
Match Profile Create equidistant loops starting from the split location. 

 
 
Switch Profile Flips the number of loops so that they END at the split location instead of 

start at the split location. 

 

Blast (Delete faces and points) 
The blast tool lets you remove faces (and points). 
 
 
To interactively blast faces (via scene view), select the faces and hit the DEL key. 
 
 
To non-interactively blast faces (via network view), connect your geo to a blast node. 
 
 
Regardless of how you did things, the properties panel will give you a bunch of settings that’ll let 
you change how the blast works… 

 
 
Group The points/faces to delete. 

 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 



 
If empty, it deletes everything. 

 
Group Type If you’re dealing with faces or points. 
 
Recompute Normals Recomputes the normals for whatever that was a sibling of whatever got 

deleted. 
 
Delete Non Selected Deletes the inverse of whatever you specified in Group. That means that 

whatever you specified in Groups is what will be kept. 
 
NOTE: This is super useful for splitting off a single piece of geo for 
dynamic simulations. For example, imagine you have a building as a 
whole piece. Select the windows and blast them for just the walls. Then, 
copy that blast node and select this option so you have just the windows. 
 
You can then import the windows into another Geometry node via an 
Object Merge node (look it up in the Create Geometry section of this 
doc) and treat it as a separate dynamics entity from the wall. 

Dissolve (Delete edges) 
The dissolve tool lets you remove edges. 
 
 
To interactively dissolve edges (via scene view), select the edge and hit the DEL key. 
 
 
To non-interactively blast faces (via network view), connect your geo to a dissolve node. 
 
 

NOTE: Remember that an edge can be shared by 2 faces. If you’re going to dissolve an 
edge , that means that the 2 faces it connects will be merged into 1. The points on that 
merged face have to sit on the same plane, otherwise it’ll implicitly generate triangles. 
The following example shows what happens when you delete an edge but the resulting 
points for the new face aren’t on the same plane (it’s like you never deleted anything at 



all)... 

 
 
 
Regardless of how you did things, the properties panel will give you a bunch of settings that’ll let 
you change how the dissolve works… 

 
 
Group The edges to delete. 

 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 
 
If empty, it deletes everything. 

 
Operation ??? 
 
Recompute Normals Recomputes the normals for whatever that was a sibling of whatever got 

deleted. 

Subdivision 
Subdivision lets you smooth out your polygons by automatically splitting them. 



 
 
To interactively subdivide (via scene view)... 

1. Choose Subdivide from the shelf 

 
2. Select your polygons to subdivide (leaving empty subdivides everything) 
3. Press Enter 

 
 
To non-interactively blast faces (via network view)... 

1. Connect your geo to a subdivide node 

 
2. In the properties panel, specify Group (polys to subdivide) 
3. In the properties panel, specify Creases (components to avoid subdivision) 

 
NOTE: The first input is for applying what to subdivide. The second input is for specifying 
the creases (what to not subdivide). If you don’t have a second input, you can ignore the 
creases property. You can almost always feed the same geo to both inputs. 

 
 
Regardless of how you did things, the properties panel will give you a bunch of settings that’ll let 
you change how the subdivision works… 



 
 
Group The polygons to subdivide. 

 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 
 
If empty, subdivides everything. 

 
Creases The creases are edges where you don’t want subdivide to apply (e.g. 

hard edges). 
 
Click arrow to select interactively in scene view. Follow the prompts in 
the scene view. 
 
If empty, it won’t apply creases to anywhere. 
 
NOTE: The second input is for specifying the creases. If you don’t have 
a second input, you can ignore the creases property. You can almost 
always feed the same geo to both inputs. 



 
Algorithm Stick to Houdini Catmull-Clark. Otherwise you won’t get support for 

creases. 
 
Depth How many iterations of subdivision to apply. 
 
Crease Weight Make sure Override Crease Weight is selected and set Crease Weight to 

the same value as Depth. This makes sure the creases you selected 
remain sharp. 

Normal (Generate or correct normals) 
Attempts to generate normals on the input. 
 
You can add/fix normals in the network view. Drop a Normal node and connect whatever 
geometry you want to it... 

 
 
You can choose what level the normals are applied and how the normals are determined... 

 
 

NOTE: To actually see the generated normals, you can use the Scene view and switch 
on show normals in the toolbar on the right-hand side… 

 
You can also switch to the geometry spreadsheet to see the N attributes added to your 
points/vertices/faces/whatever. 



Utility Nodes 

Merge (Combine geometry/outputs) 
The merge tool brings two or more separate outputs (e.g. of geometry) together. 
 

NOTE: For geo, how is this different than a Boolean node set to union????? It looks like 
union won’t work unless the geo is intersecting???? 

 
You can merge nodes in the network view. Drop a merge node and connect whatever geometry 
you want to it (no limit). The output of the merge node should contain everything? 
 
There’s nothing special in the properties panel for this… 

 
 

NOTE: Is this node giving you a warning? Check the attributes of your inputs at various 
levels via the geometry spreadsheet.  For example, does your first input have normals 
on primitives (faces) but your other input have normals on vertices? Mismatches and 
missing attributes may cause warnings to show up, but these may not always be a 
problem. See the attributes section for more info. 

Copy and Transform 
Copies input and applies transformations, multiple times (successively). For example, if you 
input a box, you can choose to copy that box 5 times and offset the X translate by -5 for each 
copy. 
 
You can copy nodes in the network view. Drop a Copy and Transform node and connect 
whatever geometry you want to it... 



 
 
Then, set the number of times you want it to be copied and which transform properties to offset 
for each copy... 

 
 

NOTE: A copy count of 1 means no actual copies. You’re just passing through the 
geometry when you select 1. Select 2 or more to get actual duplication of geometry. This 
is why the property is called Total Number. 

 

 

Material Nodes 

Color 
You can apply color(s) to components. 
 



It’s fairly straight-forward what to do with this node. Go into the Network view and drop a Color 
node, then hook your geometry into it… 

 
 
In the parameters pane, choose the components which you want the color to apply to. You can 
do so by clicking the arrow on the right of the Group. 

 
 
The other parameters here should be straightforward. Class determines what component type 
to apply the geometry to (e.g. faces or points or edges or whatever). Color type can be set to 
Constant or Random (or a few others). Everything after that point will be dependent on what 
color type was set to. 
 

NOTE: If you go into the geometry spreadsheet, you can see the color show up under 
attributes for whatever component type you used for Class (Cd is the name of the 
attribute). 

 

Material 
Applies materials to components. 
 

NOTE: Before you can apply materials, you need to bring in your materials using the 
Materials Palette view (in the same section as the network view when under the Build 
desktop). 



 
You can select from the left pane, and move over to the right pane by pressing the right 
arrow or by dragging-and-dropping over. These create the materials for you under the 
/mat namespace (or the /shop namespace which is collapsed below -- look at bottom 
lefthand side of right pane), which you can navigate to in the network view and tweak as 
you see fit. 
 
A discussion on materials is outside the scope of this document, but if you switch your 
network to /mat you can change the properties of these materials. It’s very similar to 
Arnold shaders: sub-surface scattering, specular, reflectivity, diffuse, etc..  
 
NOTE: In Houdini15, these would get created under /shop (shader OPS). Now you can’t 
create these under /shop anymore. Why????? 

 
It’s fairly straight-forward what to do with this node. Go into the Network view and drop a 
Material node, then hook your geometry into it… 

 
 
In the parameters pane, choose the components which you want the color to apply to. You can 
do so by clicking the arrow on the right of the Group. Once you’ve done that, select the material 
you want to use by clicking the right-most button next to Material (will open a selection menu of 
materials under /mat). 



 
Note that you aren’t limited to one material. You can add multiple materials for different parts of 
the geo. In the example above, we have 3 different materials being added to 3 different parts of 
the geo. 
 

NOTE: You typically would have these groups pre-defined via group nodes (especially 
for materials). See the Group Nodes section for more information. 
 
NOTE: If you click the arrow never to Group, it’ll actually ask for a grouping rather than 
let you put in arbitrary components. You can turn this off by disabling the group selection 
toggle. You need to do this every time for Material nodes… 

 

UV Unwrap (Generate or correct UVs) 
Attempts to generate UVs for the input. 
 
You can add/fix UVs in the network view. Drop a UV unwrap node and connect whateer 
geometry you want to it… 

 
 
You can choose how the UVs get applied… 



 
 

NOTE: To actually see the generated UVs, you can use the Scene view and switch your 
view from perspective to UV (shortcut is Space+5)… 

 
You can also switch to the geometry spreadsheet to see the UV attributes added to your 
points/vertices/faces/whatever. 

Light and Camera Nodes 

All Light Nodes 
Houdini (mantra) provides a bunch of lights that are very similar to Arnold and Maya lights… 

● Point Light → emits light equally in all directions 
● Area Light → a rectangle/disk/whatever that emits light 
● Geometry Light → similar to having a polygon mesh in Arnold that you set to emit light 
● Distant Light → parallel rays, as if the sun were shining 
● Environment Light → provide an HDR image and get light emitted based on that -- 

similar to mentalray’s image based lighting or Arnold’s skydome light 
● Sky Light → how is this different from the environment light above??? 

 
Add them to your scene and move them around just like any other scene node. You can find 
them in the Light shelf (2nd shelf set in the build desktop) or via the tab menu. 

 
 



An easy to position a light is through the scene view. You can make it so as if you’re looking 
through the light, and orient it as you move around your scene. To do this… 
 

1. Select the light in the camera dropdown on the top-right of the scene view (just below the 
top toolbar) 

2. Toggle the lock camera/light lock button on 
3. Orient your view around, just as normally would 
4. Toggle the lock camera/light lock button off 

 
 
 
Almost all lights come with many properties that are similar to Arnold. They probably work just 
like Arnold does. The properties panel has sections for increasing the light sampling (if stuff 
comes out too grainy) and setting intensity/exposure property and a bunch of other stuff. 
 
Intensity and exposure seem to be the main control properties here. Here’s the description of it 
from my Arnold notes… 
 
Intensity Intensity of your light. This works the same way as a regular Maya light. 

The higher your intensity is, the more light will be given off. 
 
Exposure Intensity of your light. This is different from the above setting in that it’s 

measured in f-stops (just like real photography). It’s designed to help you 
interact with real cinematographers. For example, the cinematographer 
may come and ask the artist to increase something by half a stop -- you 
can do that directly here in this setting.  
 
This is exponential… each time you go up by 1, it doubles the intensity of 
your light. 
 
NOTE: This is linked to the intensity in that the exposure uses the 
current intensity value as the basis for its setup. 



Camera 
Adds a camera to the scene, which a Mantra node (render node) can use to render from. 
 

NOTE: A camera is REQUIRED if you want to do renders. 
 
Add a camera node however you want. Do it in the scene view or the network view. It doesn’t 
need to be connected to anything. 

 
 
The camera properties contain the basics: positions, focal length, aperture, near clip, far clip, 
etc… Set these parameters however you see fit. Most of them are self-explanatory… 

 

 
 
An easy to position the camera is through the scene view. You can look through the camera and 
orient as if you’re looking through it. To do this… 
 

1. Select the camera in the camera dropdown on the top-right of the scene view (just below 
the top toolbar) 

2. Toggle the lock camera/light lock button on 
3. Orient your view around, just as normally would 
4. Toggle the lock camera/light lock button off 



 

Render Nodes 
Render nodes exist in the /out context (render ops / ROPS context). 

 
 
This is where you put in how you want things to be output. Almost always you want to drop 
nodes in here that specify render settings, but you can dump out geo or pass stuff to a farm or 
other things as well. 
 

NOTE: Keep in mind that different renderers likely need customized materials and lights. 
You probably can’t use Mantra’s principal shader with Arnold and vice-versa. 

 
NOTE: Pushing Houdini jobs to cuebot would be done through here via a custom node. 

Mantra 
Mantra is Houdini’s default renderer, and a Mantra node will render the output using that 
renderer. 
 
You can add a Mantra node by going to the network view, switching context to out, and inserting 
a Mantra node from the Tab menu… 



 
 
After you set down the node, YOU MUST SET A CAMERA in the properties pane. That means 
your scene NEEDS to have at least 1 camera node in it... 

 
 
You can set the samples for the render (just like you do with Arnold) under Rendering -> 
Samples in the properties pane. You should probably set your rendering engine option to 
Physically Based Rendering… 

 
 

NOTE: There are many ways to trigger a render… 
1. In the main menu… Render -> Render -> (render node name) 
2. In the main menu… Render -> Preview in MPlay  -> (render node name) 



 
3. In the left toolbar of scene view… click the movie reel (last button in the toolbar) and 
choose the render node name 

 
 
NOTE: MPlay is Houdini’s version of fcheck (Maya’s image playback thing)???? 

Keyframe Animation 
The lower portion of the Build Desktop holds the animation controls. Almost everything here is 
exactly the same as Maya’s animation controls… 

 
 
Playback controls Quickly playback, pause, and navigate the animation. 

 
 
1st outermost buttons = Jump to first/last frame 
2nd outermost buttons = Jump to first/last SCOPED frame 
3rd outermost buttons = Jump forward/backward by 1 frame 
4th outermost buttons = Play backward/forward 
Middle button = Stop playing 

 
Current Frame Current frame being shown 
 
Animation Start The 1st number is the first frame of TOTAL animation 

The 2nd number is the first frame of SCOPED animation 
 



Scoped means that the scrubber will only show frames from this point 
onward. Playing will also start from this frame. 

 
Scrubber Typical scrubber -- drag mouse to quickly scrub through animation. 
 
Animation End The 1st number is the last frame of TOTAL animation 

The 2nd number is the last frame of SCOPED animation 
 
Scoped means that the scrubber will only show frames up to this point. 
Playing will also end at this frame. 

 
Realtime If enabled, will playback animation at however many FPS the animation 

is set to. 
 
If disabled, will playback animation as fast as it can compute. 
 
NOTE: Disabled by default. You probably almost always want this on. 

 
Playback type Loop/zig-zag/play once/play backward 
 
Animation settings Go here to set global animation settings (e.g. FPS) 

 

 

Setting Keyframes 
Houdini supports traditional keyframe animation. The interfaces are very similar to what Maya 
provides. 



 
To animate an object based on some properties… 

1. Select the object. 
2. In the parameter pane, right-click on the property (or label for a property group) and 

choose Channels and Keyframes -> Set Keyframe. 
 
The property will turn green. 

 

 
3. Scrub to the point in the animation where you want to change the values for that 

parameter, change it, and then choose Channels and Keyframes -> Commit Change. 
 
The property will turn brown when you change it, then back to green when you commit it. 



 

 
 
 

NOTE: Want to remove the keyframe-ability of a property?? Right click and select Delete 
Channel. 
 
NOTE: Want to remove a keyframe? Right click, Channels and Keyframes, and Remove 
Keyframes. 

Animation Editor 
The animation editor contains Houdini’s equivalent of Maya’s dopesheet + graph editor. It’s 
almost exactly the same. 
 

NOTE: Viewing shortcuts are the same as the network view. G to frame up on channels 
selected. H to view everything. 

 



 
 
Mode Switch between editing curves, dopesheet, and tabular view.  
 
Multi-graph Display If enabled, each parameter selected will show in its own graph. The 

graphs will be stacked ontop of eachother. 

 



 
Tie/Untie Handles Similar to Maya’s feature where you can break up the up the bezier 

handles. You can use this so to make it easier to have abrupt transitions 
between keyframes. 

 
 
Parameters The parameters showing up in the editor. You can select which 

parameters show up in the editor via the label. 
 
NOTE: The labels may be super small. If that’s the cause, just mouse 
over between the label and the divider and drag them out.... 

 →    
 
Editor Just like Maya’s editor. Move keyframes and handles around for specific 

parameters. Basic stuff. 

Scripting References 
You can set properties based on the current frame number. 
 
For example, let’s say you want your X rotation to change based on what animation frame 
you’re currently at. You can reference the animation frame by using $F. 

 
 
Now let’s say you want to that rotation to speed up. You want it to go 2.5 times as fast. You can 
change that expression to be $F*2.5… 

 
 



NOTE: Remember that you can left click a label to show the value of what is computed. 
So in the example above. If you click the rotate label it’ll show you the value for the 
current frame. This value won’t update while you playback the animation, but it will 
update when you stop the playback. 

Physics Animation (Dynamics) 
This physics portion of Houdini is called dynamics. Essentially this is just Houdini’s interface to 
the Bullet open source library (and other related physics libraries). 
 
You set physics parameters on objects here, almost exactly the same as those when you were 
playing with Box2D. There’s a generic gravity setting, and then you have impulse (initial 
velocity?), velocity, angular velocity, density, bounce, friction, etc.. etc.. 
 
Still unsure how to apply force? I’m sure this will all be detailed in other tutorials. 
 
 
There are 2 shelves that were detailed here... 

1. Collision and Rigid Bodies are for actually setting up the physics properties. 
 
These are located in the 2nd shelf set if you’re using the build desktop. 

 

 
2. Modeling is for doing stuff like breaking or pre-shattering geometry. You can use this for 

doing things like pre-shattering windows so you can smash stuff through it and watch the 
pieces fly out everywhere. 
 
These are located in the 2nd shelf set if you’re using the build desktop. 

 
 
Once you create your dynamic bodies and stuff, the calculations for them be done AS YOU 
SCRUB YOUR ANIMATION SLIDER / AS YOU PLAY YOUR ANIMATION. 
 
Calculations are done once and then cached. You’ll know which frames are calculated because 
the timeline will show blue for those frames. 



 
 
If you change something, the cache will get nuked and the computation will happen again the 
next time you scrub/play from frame 1. YOU HAVE TO GO BACK TO FRAME 1 FOR THE 
ANIMATIONS TO RECOMPUTE, otherwise you’ll play stale frames. You’ll know your frames 
are stale cause they’ll change color from blue to orange. 

 
 

NOTE: Keyframe animations and animations from dynamics don’t seem to be mutually 
exclusive? You can have some geo keyframed and others animated dynamically. 

Scene Scale 
NOTE: This is a replace of a section way earlier in the document, but it’s super important 
so I copied it here as well. This stuff is straightforward for any physics engine (which 
Bullet is). There was a similar concept for Box2D as well. 

 
Scene scale is a super important concept when it comes to Houdini. The size of your objects 
has a direct effect on the way in which your simulations run. This is exactly like when you were 
using Box2D on Android. 
 
By default, Houdini is set to treat 1 unit as 1 meter in length / 1 kg in weight. You generally don’t 
want to change these values, but you can do so by going to Edit -> Preferences -> Hip File 
Options… 



 

 
 

NOTE: If you’re having problems visualizing this, think of a building collapsing. How long 
did it take the world trade center building to fall to the ground? Now imagine if the 
buildings were shrunken down to the height of a smartphone. 
 
In the new shrunken scale, the building would fall down much faster. The pieces falling 
to the ground would be much lighter. They wouldn’t be in the air as long. They’d have 
less impact when they hit the ground. They’d have less weight. etc.. 

Creating Dynamics for Objects 
At the scene view, you can make any of your geometry nodes objects for use in dynamics. 
 

NOTE: Remember we’re messing around with the high-level geometry nodes here, not 
the stuff in the geometry nodes. The final geometry computation is treated as a whole. 

 
There are multiple types of rigid bodies available: 

● RBD Object ← solid objects that have physics applied? 
● RBD Fractured Object ← fractured objects that have physics applied? e.g. windows? 
● Static Object ← doesn’t move but can be interacted with by other dynamic objects 
● Ground Plane ← infinite ground plane 

 



NOTE: Those are 4 we’ll be discussing, but there’s a ton of shit here and you should 
probably go over another lesson on it instead of messing around with it. 
 
NOTE: The difference between RBD Object/RBD Fractured Object and Static 
Object/Ground Plane are that the RBD objects are actually simulated, while the other 2 
are things that the simulated objects can interact with (but they don’t actually move 
themselves). 

 
Whenever you create any of these, it’ll automatically create a “AutoDopNetwork” node at the 
root /obj level (if one doesn’t already exist). This node will be of type DOP Network (dynamic 
OPs), and for each rigid body object you have in here, a mirror node will be created. 

 
 
These mirror nodes inside the AutoDopNetwork will be how you control physics properties. For 
example, if we checkout the f14d node’s parameters… 



 
You can see that the node is referencing our original f14d geometry object (/obj/f14d). 
 

NOTE: Notice how the path specifically checks for /obj/f14d/dopimport1. If you look 
inside the f14d geometry object, you can see a few new nodes have been added to the 
end of the chain to help with the dynamics simulations as well… 

 

Setting Gravity 
Inside the AutoDopNetwork node, the 2nd last node is gravity1. This is where you’d set your 
gravity… 

 



 
The important property here is Force, and by default it’s set to the correct value (-9.8 meters in 
the Y-axis). If you want to change it, you can. 

Setting Physics Properties for Objects 
Remember the for each rigid body object you create, a mirror node will be created in the 
AutoDopNetwork. These mirror nodes are where you can set your physics properties. 
 
You can find them in tabs within the last section. 
 
Almost all objects will have a physical tab. The physical tab defines the physics properties of the 
object. 

 
Describing what each of these does is out of scope, but a lot of them should be self-explanatory. 
They mirror box2d properties. 
 
If your object ISN’T a ground or static object, you’ll also have a initial state tab. This is the state 
of your dynamic object when the scene first starts… 

 
Once again, describing what each of these does is out of scope, but it should be 
self-explanatory. They mirror box2d properties. 



 
NOTE: You almost never ever want to change position. The lesson didn’t even give a 
single use-case for this. 

Collision Geometry 
The collision geometry put on your object is different from the actual geometry. It’s more 
simplified. 
 
Remember the for each rigid body object you create, a mirror node will be created in the 
AutoDopNetwork. These mirror nodes are where you can set your see and tweak your collision 
geometry. 
 
To see/change the collision geometry…. 

1. Go to the mirror node in the AutoDopNetwork 
2. Go the Bullet Data tab in the parameters pane (this tab may be hidden under the 

Collisions tab depending on node type) 
3. Enable Show Guide Geometry 
4. Change Geometry Representation (if desired) 

 

 →   
 
The default collision geometry being produced is ‘convex hull’. It produces geometry around 
your object such that it doesn’t cave in. There are multiple different options here and you can 
change them however you see fit. You can change this option 
 

NOTE: Clearly, the example above is caving in on certain areas. I think this is because 
the geometry object for this plane is made up of multiple distinct meshes -- they are not 



fused together. Maybe what’s happening is a convex hull is being created for each 
distinct mesh? 

 
A lot of times this type of collision geometry is good enough, but there are cases where this 
won’t give you want you want. For example, imagine you have a soccer goal post. If you use 
convex hull for the collision geo, the open face of the goal post will be covered (convex means 
that the geometry doesn’t cave in). So if a soccer ball was going into the net, it would hit an 
invisible wall and bounce off just before entering. 

 
 

NOTE: Notice the 2 options in the properties pane: “Color” and “Deactivated Color”. This 
shows which objects are “active” during the physics simulations. So if you do some 
physics and enable  “Show Guide Geometry” and scrub through your animation, you’ll 
see which objects are “active” via the colors. 
 
This is EXACTLY like the view in Box2D’s debug renderer thing. Objects are at rest for a 
certain period of time (and aren’t around other moving objects?) will no longer be 
considered for calculations and will be deactivated. If they’re collided with, they’ll become 
active again. 
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Introduction 
This physics portion of Houdini is called dynamics. There’s a ton of different things you can do 
with dynamics, but this text is specifically about handling collisions between objects. You can 
use this instead of normal keyframe animation to get realistic looking animations going. All the 
basic parameters are there: gravity, velocity, angular velocity, density, bounce, friction, etc.. etc.. 



 
The shorthand for dynamics is DOPs (Dynamic OPerators). 

Dynamics Network 
The following is an example of a DOPS network. This specific network (AutoDopNetwork) is 
automatically created by Houdini when you use the rigid-body shelf, but networks that you 
create manually will look very similar. 
 
Essentially what happens is that, you have your various geometry nodes at the /obj level. In 
your DOP network, you create DOP rigid-body/static/collision nodes that reference those 
geometry nodes. Those rigid-body/static/collision nodes are then passed to “solvers” and 
output. 
  

 
 

NOTE: If you’re using a AutoDopNetwork and your nodes aren’t organized, hit L to 
layout the nodes in a nice tree structure. 



 
There are lots of different types of solvers, but the 3 most important ones are… 

● Static → only collides with stuff, never moves 
● Rigid body → collides with stuff and moves, but is rigid 
● Finite element → collides with stuff and moves, but is squishy 

 
NOTE: What are solvers? Solvers is a fancy name for “rule book”. Essentially all it does 
is contain the logic to do physics simulations. You’ll notice that there are 2 types of 
solvers in the example: rigidbody and static. 
 
Static is for static collision geometry (stuff that can be collided with but never moves). 
Rigidbody is for objects that have physics actually applied (e.g. rag-doll on a model). 
 
NOTE: What about gravity? That’s handle by the gravity node just before the output 
node. 
 
NOTE: All of this is just an interface to bullet. I imagine bullet’s actual interface is nothing 
like this and more like what Box2D is like. For example, gravity would likely be a 
system-wide property that can only be set once. WTF happens if I have 2 gravity nodes? 

Dynamics Playback 
Once you create your dynamic bodies and stuff, the calculations for them be done AS YOU 
SCRUB YOUR ANIMATION SLIDER / AS YOU PLAY YOUR ANIMATION. 
 
Calculations are done once and then cached. You’ll know which frames are calculated because 
the timeline will show blue for those frames. 

 
 
If you change something, the cache will get nuked and the computation will happen again the 
next time you scrub/play from frame 1. YOU HAVE TO GO BACK TO FRAME 1 FOR THE 
ANIMATIONS TO RECOMPUTE, otherwise you’ll play stale frames. You’ll know your frames 
are stale cause they’ll change color from blue to orange. 

 
 

NOTE: Keyframe animations and animations from dynamics don’t seem to be mutually 
exclusive? You can have some geo keyframed and others animated dynamically. 
 



NOTE: Remember to enable the realtime playback button. Otherwise Houdini will 
playback as fast as possible… 

 

Scene Scale 
Scene scale is a super important concept when it comes to Houdini. The size of your objects 
has a direct effect on the way in which your simulations run. This is exactly like when you were 
using Box2D on Android. 
 
By default, Houdini is set to treat 1 unit as 1 meter in length / 1 kg in weight. You generally don’t 
want to change these values, but you can do so by going to Edit -> Preferences -> Hip File 
Options… 
 

 
 

NOTE: If you’re having problems visualizing this, think of a building collapsing. How long 
did it take the world trade center building to fall to the ground? Now imagine if the 
buildings were shrunken down to the height of a smartphone. 
 
In the new shrunken scale, the building would fall down much faster. The pieces falling 
to the ground would be much lighter. They wouldn’t be in the air as long. They’d have 
less impact when they hit the ground. They’d have less weight. etc.. 



Rigid Body Objects 
Rigid bodies are physics objects that can move around and collide with stuff. The shape and the 
volume of the geometry won’t change, it’ll only be transformed each frame as per the physics 
calculations. 
 
To create a rigid body object… 

1. Select your object 
2. Go to the Rigid Body shelf and select RBD Object 

 
 

NOTE: Using RBD Objects will create what’s called a packed object. Packed objects 
can’t be simulated with finite element objects (objects that go squishy). If you’re going to 
have finite element objects in your scene, use RBD Hero Object. They’re less efficient 
but they work with everything.  

 
Once you do this, 2 things will happen… 

● You’ll get a new node called AutoDopNetwork (if it didn’t already exist) which contains a 
node with the same name as the object you’ve applied RBD to. 

 

 



● Your object you’ve applied RBD to will get a few nodes added to it 

 

 
 

NOTE: The extra nodes that are added into your object, you generally don’t want to 
touch those. They set things up for use in dynamics and create links between your 
geometry and dynamics. 

 
The AutoDopNetwork node is what you traverse into if you want to change the physics 
properties of your node (e.g. bounciness/friction/etc..).... 

Physical Properties 
You can change the physical properties for the simulation of your object by… 

1. Traversing into the AutoDopNetwork. 
2. Selecting the RBD object for that object. 
3. In the properties pane, going to the Physical tab. 

 

 
 



Bounce Bounce is how bouncy the object is. Note that the value applied on 
collision is a mix of this value and the bounciness value from the object 
being collided with. 

 
Friction Friction is how much friction the object has to it (e.g. is it like ice or 

sandpaper?) . Note that the value applied on collision is a mix of this 
value and the friction value from the object being collided with. 

 
NOTE: Density = volume * mass. If you disable the Compute Mass checkbox, you can 
specify mass directly. 
 
NOTE: No idea what Rotational Stiffness is used for. Best not to change it. 

Initial State 
Initial state is the physics state of the object at the start of the scene. For example, when the 
scene starts the object may be throttling down the Z axis. 
 
You can change the physical properties for the simulation of your object by… 

1. Traversing into the AutoDopNetwork. 
2. Selecting the RBD object for that object. 
3. In the properties pane, going to the Physical tab. 

 

 
 
Velocity The direction this object is moving + the force it’s moving at. 
 
Angular Velocity How fast this object is spinning + the direction it’s spinning at. 
 



NOTE: You almost always never want to touch Position and Rotation. These are 
available for artists to make small tweaks. 

Collisions 
Go to the Solver Engines and Collision section and read it THOROUGHLY. 
 
Once you’re done that, read the Optimized Collisions section to find out strategies for faster 
simulations. 

Collision Objects 
Collision objects are physics objects that can’t move around but are used for collisions with 
other objects. Nothing will change about the geometry, not even the transform. 
 

 
 
There are many different types of collision objects you can create… 

● Static Object → turns your geometry into a collision object 
 
To create... 
1. Select your geometry object 
2. Got to the Collisions shelf and select Static Object 

 
● Ground Plane → an infinite ground plane not linked to any geometry object. 

 
To create... 
1. Got to the Collisions shelf and select Ground Plane 

 
 

NOTE: What about the other 2? 
- No idea what Deforming Object is used for. 
- Terrain Object is like a static object but meant specifically for cases where the object is 
uber thin (e.g. a deformed grid that’s meant to represent a terrain) -- apparently this type 
of static object needs volume applied to it or something so it works better with 
collisions/solvers/whatever. 



 
Once you do this, 2 things will happen… 

● You’ll get a new node called AutoDopNetwork (if it didn’t already exist) which contains a 
node with the same name as the object you’ve applied collision to. 

 

 
● Your object you’ve applied collision to will get a few nodes added to it OR your collision 

object will generate some new geometry. 

 

 
 

NOTE: The extra nodes that are added into your object, you generally don’t want to 
touch those. They set things up for use in dynamics and create links between your 
geometry and dynamics. 

 



The AutoDopNetwork node is what you traverse into if you want to change the physics 
properties of your node (e.g. bounciness/friction/etc..).... 

Physical Properties 
You can change the physical properties for the simulation of your object by… 

1. Traversing into the AutoDopNetwork. 
2. Selecting the collision object for that object. 
3. In the properties pane, going to the Physical tab. 

 

 
 
Bounce Bounce is how bouncy the object is. Note that the value applied on 

collision is a mix of this value and the bounciness value from the object 
being collided with. 

 
Friction Friction is how much friction the object has to it (e.g. is it like ice or 

sandpaper?) . Note that the value applied on collision is a mix of this 
value and the friction value from the object being collided with. 

 
NOTE: No idea what the rest of the properties are used for. They have descriptions but I 
don’t really understand what they mean. 

Collisions 
Go to the Solver Engines and Collision section and read it THOROUGHLY. 
 
Once you’re done that, read the Optimized Collisions section to find out strategies for faster 
simulations. 



Finite Element Objects 
Finite element objects are objects that can move around and collide with stuff (just like rigid 
body objects). But, the shape and the volume of the geometry can also change. So, in addition 
to transforming based on physics calculations, the physics calculations will also deform the 
geometry. 
 

NOTE: Cloth sims use to happen via finite element solver in Houdini 15, but in Houdini 
16 it’s been updated to use its own solver (called cloth solver). 

 
To create a finite element object… 

1. Select your object 
2. Go to the Solid shelf and select Solid Object 

 
 

NOTE: It seems that Organic Mass/Tissue will generate the same thing, just with 
different physics properties (e.g. more stiff / less stiff)? 

 
Once you do this, 2 things will happen… 

● You’ll get a new node called AutoDopNetwork (if it didn’t already exist) which contains a 
node with the same name as the object you’ve applied RBD to. 

 

 



● Your geometry object will get a few nodes added to it 

 

 
 

NOTE: The extra nodes that are added into your object, you generally don’t want to 
touch those. They set things up for use in dynamics and create links between your 
geometry and dynamics. 

 
The AutoDopNetwork node is what you traverse into if you want to change the physics 
properties of your node.... 

Physical Properties 
You can change the physical properties for the simulation of your object by… 

1. Traversing into the AutoDopNetwork. 
2. Selecting the solid object for that object. 
3. In the properties pane, going to the Model tab. 

 



 
 

NOTE: It looks like these values were really finicky with older versions of Houdini. In 
certain cases they would cause the deforming geometry to explode. I couldn’t get a 
similar effect to show up in Houdini 16. Houdini 16 seems to have solved that issue? 

 
I’m unsure what all of these settings do. The ‘Initialize Behaviour’ dropdown up top will change 
the parameters to represent common materials (e.g. rubber). 
 
 
Damping Ratio Officially this is described as “how quickly the object stops deforming”. 

You can also think of this as the springiness of your object. 
 
For example, imagine that you’re dealing with a cloth-like piece of 
geometry that falls/drapes over a sphere. As the cloth drapes, the ends 
of the cloth may spring back-and-forth heavily. If you jack up the 
damping ratio, this will happen less? 
 
NOTE: The lower this value is, the more jitter you have to deal with when 
your object is at rest. 

 
Mass Density Officially described as “the amount of mass per volume”. I assume this 

means the amount of mass per 1 unit squared of volume. 
 
NOTE: Remember that distance defaults to 1 = 1 meters, so 1 unit of 
volume is 1 meter squared. 

 
Shape Stiffness Officially described as how much your object resists changes to its 

shape. I describe this as how ‘melty’ your object is. The lower it is, the 
more your object melts. 



 
Remember that this value is dependent on the mass density value. 

 
Volume Stiffness Officially described as how much your object resists changes to its 

volume. 
 
Realistically, modifying this value doesn’t seem to do much other than 
maybe make the object less drape-y as it melts (this is with super high 
values). It’s like as the object deforms and goes flat (this happens with a 
very low SHAPE stiffness or very high mass density), the volume 
stiffness seems to prevent it from draping over the object. It’s almost like 
throwing a heavy rubber mat over an object. 

 
Friction Friction is how much friction the object has to it (e.g. is it like ice or 

sandpaper?) . Note that the value applied on collision is a mix of this 
value and the friction value from the object being collided with. 

Accuracy 
You may notice a small amount of bleedthru with your finite element object when it collides, 
especially if one of your objects goes really loose and drapes over the other (low surface 
stiffness). 
 
Increasing the poly count of the objects doesn’t seem to do anything. What’s going on is that the 
nodes added to the geometry object are automatically creating tetrahedrons based on what the 
internal algorithms thinks are efficient for the object being passed into the AutoDopNetwork. 
 
Increasing the polys won’t increase the number of tets. But, we can MANUALLY increase the 
number of tets being created for the object by adding a few nodes into the chain. The more tets 
we have, the more we can stop bleeding (but the sim will also be a lot slower). 
 
To increase the number of tets… 

1. Go to your object node 
2. Delete the Solid Embed node (or bypass it) 
3. Add a Remesh node and a Solid Conform node in its place 
4. Go to the Remesh node and change the Target Edge Length property 



 
 
The lower the Target Edge Length, the more tets will be generated. 
 

NOTE: Feel like doing this to a lot of objects? Shove the nodes inside a subnetwork and 
make a houdini digital asset out of it. Check out the section on subnetworks in the main 
document. 

Collisions 
Go to the Solver Engines and Collision section and read it THOROUGHLY. Finite Element 
objects use RDB, so the objects you’re colliding with should have good collision geometry setup 
for RDB. 
 
Also, the number of test in your model can be boosted (see the Accuracy subsection above) to 
help if certain parts (tight areas and hard edges?) of your finite element object is being clipped 
through. 

Cloth Objects 
As of Houdini 16, cloth no longer uses the finite element solver for simulations. Cloth objects 
have their own cloth solver that they use. I’m unsure how collisions are done here (Bullet 
solver? RBD solver? other?). 
 
You can turn an object into “Cloth” by going to the Cloth shelf and selecting Cloth Object… 



 
 

NOTE: Unlike finite element objects, this uses polygons directly. IT DOES NOT 
CONVERT TO TETRAHEDRONS. If you want more accurate simulations, just up your 
polycount. 

Physical Properties 
If you go to the AutoDopNetwork and look at the properties of whatever it was you cloth’d up, 
you’ll see properties similar to those for finite element objects… 

 
 
The Initialize Behavior dropdown lets you set these parameters to specific types of cloth (e.g. 
silk). Also, if you notice any bleed-through happening, you can try fiddling with the Thickness 
option or go under the Collision tab and fiddle with the Collision Radius option. 

Collisions 
Go to the Solver Engines and Collision section and read it THOROUGHLY. Finite Element 
objects use RDB (I think), so the objects you’re colliding with should have good collision 
geometry setup for RDB. 



Solver Engines and Collision 
There are 3 different solver engines that dynamics can use to calculate how things move and 
collide: 

● Bullet ← open-source physics engine 
● RBD ← Houdini’s internally built physics engine 
● ODE ← open-source physics engine that only deals with shape primitives (e.g. sphere) 

 
Which one gets used is dependent on the solver settings / what’s being interacted with. 
Ultimately, if you’re going to be doing anything serious with Houdini, you’ll need appropriate 
collision geometry being generated for both RBD and Bullet. 
 
Just remember these two points… 

1. Bullet is used for rigid body interactions with other rigid bodies and collision objects 
2. RBD is used for everything else (fluids, particles, volumes, cloth, finite element, etc..) 

Collision Geometry for Bullet 
By default, the rigidbody solver uses the Bullet open-source physics engine to do physics 
calculations. Bullet seems to generate collision geometry that’s more efficient for its calculations 
vs your real geometry. 
 

NOTE: You can change which engine the solver uses by going to the rigid body solver 
node and choosing something other than Bullet for the solver engine. If change it to 
RDB, none of this collision geometry stuff in here will apply to objects being fed into it -- 
instead see the RDB subsection below. 

 

 
 
You can get to the collision geometry used for the simulation of your object by… 

1. Traversing into the AutoDopNetwork. 
2. Selecting the RBD object (or Static object) for that object. 
3. In the properties pane, going to the Bullet Data tab. 



 
 
To show the collision geometry being generated for your object… 

1. Uncheck Display Geometry (so only your collision geo will show) 
2. Check Show Guide Geometry 

 
NOTE: If you play your dynamics animation while guide geo is showing, the Color and 
Deactivated Color will be used to show if Bullet is using your object for computations. 
Objects that are at rest will be deactivated until they’re interacted with again. 

 
To change your collision geometry… 
Use the Geometry Representation dropdown. By default Convex Hull is used, which is a highly 
reduced version of your geo that doesn’t cave in at all. If this isn’t good enough, you can choose 
Concave. 

 



Collision Geometry for RBD 
For anything that isn’t a rigidbody-to-rigidbody or rigidbody-to-static interaction, the RBD engine 
is used. So for example, if your rigid body collides with a finite element object/particles/flip 
fluids/volumes/etc.., RBD is used. 
 

NOTE: If your rigidbody solver is set to use RBD via its Solver Engine property, then 
your rigidbody-to-rigidbody and rigidbody-to-static interactions will also use RBD (it 
defaults to Bullet). 

 
 
The RBD Solver tab of your static/rigidbody object will have 2 tabs: Volume and Surface... 

 
NOTE: Remember to uncheck Display Geometry if you’re going to show the Collision 
Guide 

 
By default, finite element objects use “Volume Based Collision”. I think this tries to approximate 
a simple volume based on the geometry. 
 
According to the lesson, this is fast but it may not be accurate. You can turn up the uniform 
division count to make it more accurate, but if your object has a lot of large holes it still won’t be 
all that accurate. Furthermore it seems that in certain cases colliding geometry will just slowly 
bleed through the object instead of coming to rest on collision (e.g. fluids or cloth). 



 
If you want more accurate collision geometry… 

1. Uncheck Use “Volume Based Collision Detection” 
2. Switch to the Surface tab 

NOTE: Is there anything worth adjusting in the Surface tabs? You can switch from Points 
to Edges? The video says depending on the number of points you have vs the number 
of edges, one may be more efficient than the other? But wouldn’t this be an easy thing to 
automatically calculate? Why are they making you manually pick it? I think in some 
cases I saw that you could set a collision radius for surface collisions that’d give the 
collision surface some extra padding. 

 
Or, you can try generating simpler collision geometry and use that for the volume based 
collision instead. Simpler geometry means better volumes are generated. See the section on 
Optimized Collisions for more information. 

Solver Gotchas 
As far as I know, rigidbodysolver is the only solver node that lets you pick the physics engine to 
use for your simulations. So what happens when we have 2 rigidbodysolver nodes being 
merged, one set to use Bullet and the other set to use RBD? 

 
 
The behaviour slightly varies between the the various options… 

● Bullet vs RBD 
● RBD vs Bullet 
● Bullet vs Bullet 
● RBD vs RBD 

 



Ultimately I’m not 100% sure what’s going on here. From experimenting it looks like it uses the 
engine from the LAST input to the merge (remember that you can reorganize inputs into the a 
merge by going to the properties). 
 

NOTE: I was able to come to this conclusion by having 2 same sized spheres but jacking 
up the Bullet collision padding property on the second sphere. If it used the padded 
collision geometry for the collision (instead of sinking into it until it hit the actual sphere), 
it was using Bullet. No gravity was involved in the test. 
 
NOTE: Each one of the Bullet/RBD combos above seemed to act a little differently? No 
idea what’s going on here. 

Optimized Collision Geometry 
If you’re using highpoly models in your scene, you may not necessarily want to use those same 
models for your simulations. Your simulations may be able to get away with using much lower 
resolution models. 
 
Why would you want to do this? It’ll boost the speed of your simulations by a significant amount 
if you use lower resolution geometry. 
 
For example, imagine we had 2 models given to us by our modeller: a high-res model for 
rendering and a low-res model for our rigidbody simulations… 

 
 
How do we do this? 
 

1. Import both models into your scene… 

 
 



2. Convert the high-res version intro a rigid-body/static object... 
 
You’ll end up getting the typical nodes in your Geometry node and your 
AutoDopNetwork 

 
 

3. Point the RBD Object created in the AutoDopNetwork to the lowres version.. 
 
You can do this by changing the SOP Path property.  

 
NOTE: You can use the little button on the rightmost next to the text field to get a outliner 
window to quickly pick the geo... 

 
Once you do this, you’ll see the low-res version if you go into your AutoDopNetwork, but the 
high-res version when you come out… 



..vs..  
 
Notice how the water isn’t really colliding exactly with the highres geometry, but it is with the 
lowres geometry. A lot of times this is perfectly fine for a render (depends on the angle and 
various other things), and if you wanted a more accurate collision you can ask for some more 
polygons in your lowres version. 

Shrinkwrap Method 
If we don’t have a simpler geometry given to us by our modeler, we can use Houdini directly to 
generate some… 

 
 
So what’s going on here? Here’s what each node does… 

1. Object Merge → pulls in the high-res geometry 

 
 



2. Shrinkwrap → creates a convex hull polygon mesh out of the geometry 

 
 

3. Polyreduce → reduces the poly count on the convex hull 

 
You’ll need to go into the properties for this node and manually turn down the Keep % 
number to something you think is appropriate 

 
Just as you would have done if lowres geometry was provided to you, point your RBD Object in 
your DOP network to this new low-res geometry node (or, if you did this in the same geometry 
node, point directly to the polyreduce node). 
 
This produces geometry very similar to Bullet’s default Convex Hull collision geometry. Why 
would you want to use this instead? If you don’t care about the holes in your object for your 
collision (for example, my car’s rims have holes but I’m not doing any specific collision with 
those in my scene), this will generate a much better RBD collision volume and finish the 
simulation much faster. 
 

NOTE: Feel like doing this to a lot of objects? Shove the nodes inside a subnetwork and 
make a houdini digital asset out of it. Check out the section on subnetworks in the main 
document. 

Ray Method 
If we don’t have a simpler geometry given to us by our modeler, we can use Houdini to directly 
generate some… 



 
 
So what’s going on here? Here’s what each node does… 

1. Object Merge → pulls in the high-res geometry 

 
 

2. Box → generates a new polygon box 

 
By feeding in our original geometry, the box’s size will match the bounding box of the 
geometry. You’ll need to go into the properties for this node and make sure the Primitive 
Type is set to Polygon Mesh and the Axis Divisions will give you the number of faces you 
want for your low-res geo… 

 
 

3. Ray → projects rays from first input to the second input (in the direction of its normal) 
and moves the geometry to where the rays hit 



 
You’ll need to go into the properties for this node and manually set the Method to 
Minimum Distance... 

 
 
Just as you would have done if lowres geometry was provided to you, point your RBD Object in 
your DOP network to this new low-res geometry node (or, if you did this in the same geometry 
node, point directly to the polyreduce node). 
 
This produces geometry that isn’t a Convex Hull, so you can use it for those cases where you 
need a bit more detail for your collisions (e.g. it’s important for the colliding object to hit the 
bottom of the car exactly). Much like the shrinkwrap method, this will generate a much better 
RBD collision volume and finish the simulation much faster. 
 

NOTE: You may want to add in a polyreduce node at the end of this chain, just because 
it seems edges seem to accumulate more of the faces than are needed. 

VDB Convert Method 
If we don’t have a simpler geometry given to us by our modeler, we can use Houdini directly to 
generate some… 

 
 
So what’s going on here? Here’s what each node does… 



1. Object Merge → pulls in the high-res geometry 

 
 

2. VDB from Poly → converts your polygon model into voxels 

 
If you have a very large model, this may take a long time to cook during your first run. 
You’ll want to jack up your voxel size in the node’s properties so that you can reduce 
detail… 

 
 

3. Convert → converts your voxels back to polygons 

 
 

4. Polyreduce → reduces the polycount 

 
You’ll need to go into the properties for this node and manually turn down the Keep % 
number to something you think is appropriate… 

 
 

Just as you would have done if lowres geometry was provided to you, point your RBD Object in 
your DOP network to this new low-res geometry node (or, if you did this in the same geometry 
node, point directly to the polyreduce node). 
 
This produces geometry that isn’t a Convex Hull, so you can use it for those cases where you 
need a bit more detail for your collisions (e.g. it’s important for the colliding object to hit the 



bottom of the car exactly). Much like the shrinkwrap method, this will generate a much better 
RBD collision volume and finish the simulation much faster. 
 

NOTE: What the fuck is the point of this? Why don’t I just use a polyreduce node 
directly? Apparently it causes gaps??? Here’s what happened when I fed the high-res 
geometry directly into a polyreduce node and jacked the polycount down… 

 
It looks like it just randomly kills faces? 

 
NOTE: Feel like doing this to a lot of objects? Shove the nodes inside a subnetwork and 
make a houdini digital asset out of it. Check out the section on subnetworks in the main 
document. 
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Introduction 
Houdini’s fluid model is called FLIP (FLuid Implicit Particle). It’s a hybrid of 2 different toolsets. In 
the old days of Houdini, artists were given 2 ways of creating fluids: voxels are particles. 
 
Voxels (also known as volume grid / volume box) were essentially a 3D stack of boxes where 
each box would contain information about the fluid: direction, speed, pressure, surface shape, 
etc… 



 
 
Although this produced good/predictable results for a very long time, it had some problems… 

● if your fluid had to go somewhere outside of the box, it couldn’t -- it would just disappear. 
● if your fluid’s voxel resolution was too low, certain parts could disappear at random. 
● it was inefficient in that you would have to know the largest possible volume your fluid 

would consume before hand -- even if you were using a small piece of that volume in the 
majority of your frames, calculations for the entire volume would have to be done every 
frame. 

 
Particles were essentially a cloud of points that would make up a fluid. 

 
 
Unlike voxels, they weren’t confined to a certain volume (they could go anywhere) and they 
were fast to calculate. But, they were also very unpredictable in that they could explode or 
otherwise act erratically for no apparent reason + they required the extra step of having to 
generate a surface. 
 
FLIP is a hybrid of both the particle and voxel systems. FLIP essentially calculates each 
particle’s movement inside a voxel, and the overall voxel shape is defined by where the particles 
are defined in space. 



 
 
So essentially FLIP is just the volume system and the particle system talking back-and-forth to 
each other. One is dependent on the other. 
 

NOTE: The only particle thing to note here is that you can apply both volume forces and 
particle forces to your fluids. This is described in the forces section. 

Create Fluids 
The various ways to create fluids are documented below. Keep in mind that when you do create 
a fluid, a few things end up happening… 
 

● AutoDopNetwork will get created (if it doesn’t exist already). 

 
● *_fluid geometry will get created -- show you your fluid particles. 

 
● *_fluidinterior geometry will get created -- used for rendering the final fluid material. 

 

 
● Any original geometry you used as part of the creation may have stuff added to it to 

make it work with the fluid stuff in the AutoDopNetwork. 
 
The inside of your AutoDopNetwork will have a portion added to it for FLIP fluids… 



 
 
The important thing with this is that FLIP fluids will be confined to a certain bounding box. If they 
go past the extent of the bounding box they will either disappear or collide (depends on your 
settings). 
 
See the Fluid Bounding Box section for more information. 

Create 
You can convert pretty much any shape into a finite amount of fluid via FLIP Fluid from Object in 
the Particle Fluids shelf… 

 
 
If you don’t already have an object selected when you do this, it’ll ask you to select one and 
press Enter (this is done inside the scene view). Once it does the conversion, your object will 



get hidden and in its place will be the particles for your fluid. 

 
 
Notice that the original geometry (box_object1) gets hidden once the conversion is complete. If 
you wanted to expand or reshape or otherwise manipulate the shape, you need to do it on this 
hidden original geometry. 
 

NOTE: Unsure what fluid and fluidinterior are for? Check the parent section. 

Emit 
Just like how you could emit particles from some shape, you can also emit fluid from some 
shape. You can do this using the Emit Particle Fluid item in the Particle Fluids shelf...  

 
 
If you don’t already have an object selected when you do this, it’ll ask you to select one and 
press Enter (this is done inside the scene view). 
 
It’ll then ask you to select the fluid object you want to emit into (if any). For this, go into your 
AutoDopNetwork and select a FLIP object that feeds into the solver that you want your 



generated particles to go into, then go back into the scene view and hit Enter. 

 
NOTE: Unsure what fluid and fluidinterior are for? Check the parent section. 

 

 
NOTE: If you don’t want it to have a destination, don’t select anything and hit Enter. The 
AutoDopNetwork will create a brand new solver and merge it with any existing 
flipsolvers. When this happens, the water particles from the different flipsolvers won’t 



end up interacting with each other -- they’ll just go through as if it was thin air. 

 
 
If you want to produce more water particles at once, you’ll have to scale up the object you’re 
emitting from. 
 

NOTE: This particular way of creating water lets you set a TTL on the particles. See the 
Fluid Destruction section for more information. 

Fill/Sculpt 
You can make it so that you have a specific volume that gets filled with water in the very 
beginning (without having to spend frames filling it up with an emitter or anything like that). This 
is done via Sculpted Particle Fluid in the Particle Fluids shelf... 

 
 
Make sure you have nothing selected when you click this shelf item. When you do click it, you’ll 
prompted in the scene view to make 3 selections (pressing Enter after each selection)  

● object that represents how high the water should be 
● object that represents the terrain 
● object(s) that represents obstructions the water can hit 

 
NOTE: Be careful with what you select as a terrain object. It determines what direction it 
should try filling in by the normals on that object. So if you notice water filling on the 
outside of your terrain instead of the inside, you need to reverse the normals. You can 
do this by shoving a Reverse node into your geometry... 

 



 
NOTE: Unsure what fluid and fluidinterior are for? Check the parent section. 
 

A few things happen once you do this… 



1. your terrain will get a Terrain collision object associated with it (as if you went under the 
Collisions shelf and chose Terrain). 

 
2. your obstructions get static objects associated with them (as if you went under Collisions 

shelf and chose Static). 
 
(no picture here because I didn’t choose any, but this would be getting fed into the 
staticsolver along with the terrain) 
 

3. your water level geometry node gets renamed with a “_sculpted_setup” suffix and stuff 
gets added to it such that it generates particles in the terrain shape up the water level 
you specified. 

 
 
 
There are lots of problems here… 



 
The end result of the example above was that the water would not stay in the basin. It seems 
that the particles would seep and gradually get stamped down (or disappear?) as the simulation 
progressed. 

 
NOTE It almost seems as if the water is going down to some invisible basin underneath 
the sphere. See the picture of the volume based collision geometry below. 

 
The collision geometry generated on the terrain in the example above is extremely messed up. 
It uses volume based collision by default and does a terrible job of creating the collision 
geometry. Switching to surface based collision seems to help only sometimes. The problem is 
that you don’t have the option to set Collision Radius on a Terrain object like you do with a 
Static Object, which means in certain cases seeping of water between the seams still happens. 

 
 

NOTE: Adding thickness to the terrain geometry (polyextrude node) did nothing. 
 
NOTE: One potential workaround I found to the collision issue was to manually remove 
the terrain object from the AutoDopNetwork (including whatever was added to the 
Geometry node to get it in there) and place it back in as a Static object. That way you’d 
get access to the extra options for Surface collisions. BUT, the problem here is that the 
fluid particles just disappear as gravity pulls them down and they collide -- it’s as if 
they’ve hit the bottom of the fluid bounding box. I don’t know how to fix this but there’s 



probably a way. 

 
 
NOTE: Okay, so after continued experimentation, it looks like that it may be this is 
expecting terrain-like geometry. That is, if I can a normal grid and sculpt some grooves 
into it, then use another grid for the water-level, everything works perfectly fine. Surface 
collision mode on the terrain object also seems to work well. I don’t know why my 
original cut-off circle geometry didn’t work. 

 
For best results you should give your terrain/static objects some depth (make sure they 
aren’t thin like paper) 

Sandbox (FLIP Tank) 
A FLIP tank is almost the same thing as creating a box and converting it to a fluid, except that… 



● the bounding box for the solver will be linked to the bounds of the box object 
    (this is called fluidtank_initial) 

● the fluid will fill roughly 50% of the bounding box 
● the fluid will collide with the bounding box instead of go through it 

 
FLIP tanks are often used as a sandbox to play with water. You can do create a FLIP tank via 
the FLIP Tank item in the Particle Fluids shelf...  

 
 
 

 

Destroy Fluids 
There are a few ways to destroy fluid particles. 

Bounding Box Collision 
You can control what happens to your fluid particles when they hit the walls of your fluid solver’s 
bounding box. To see how to do this, check out the Fluid Bounding Box section. 
 
The default for whether your fluid disappears or not depends on the exact way your fluid was 
created. 
 
For example, if you created your fluid from the FLIP Fluid Object item in the Particle Fluid shelf, 
the fluid particles disappear when they hit the bounding box walls. But, if you created your fluid 
using the FLIP Tank item under the same shelf, they’ll collide instead of disappear.  
 



NOTE: It should be obvious why this is. FLIP Tank is meant to be a sandbox playground. 
What good is a water testing playground if there’s no water. 

Particle TTL (time-to-live) 
You can set TTLs on fluid particles generated from an emitter (if you chose the Emit Particle 
Fluid item in the Particle Fluids shelf)... 

 
 
If you want to kill water particles after a certain amount of time (control lifespan), you can do so 
by going to the Source Volume node in your AutoDopNetwork and selecting the Particle 
Operation tab. Enable Life Expectancy and set the value to whatever you need to (value is in 
seconds). 

 
 
Once you set this, you also need to go to the solver and specifically tell it to age particles and 
reap particles. 



 
 

NOTE: If you set the solver to enable age+reap particles, technically you can add an age 
parameter to particles generated from anything? If you look at the geometry 
spreadsheet, you can see what extra attributes were added to each particle to get them 
to age… 

 
 
The life attribute seems to be the big one here. It tells the solver how long to keep the 
particle around. There doesn’t seem to be a node available in the dynamics context to 
add an attribute to these particles, so it must be done via VEX or python? I don’t know 
enough about Houdini to do that yet, but I think it’s definitely doable. 

Sink 
Just like how you could emit fluid particles from some shape, you can turn some shape into a 
sink for fluid particles. You can do this using the Sink from Objects item in the Particle Fluids 
shelf...  

 
 
If you don’t already have an object selected when you do this, it’ll ask you to select one and 
press Enter (this is done inside the scene view). 



 
It’ll then ask you what “smoke object” you want your sink added to. This is probably a bug. What 
it’s asking for is the fluid solver you want your sink added to. For this, go into your 
AutoDopNetwork and select a FLIP object that feeds into the solver that you want your fluid 
particles disappear from, then go back into the scene view and hit Enter. 
 
You shouldn’t get any new objects under your /obj context. But, the object you selected to be 
your sink will have some stuff added to it… 

 
 
In addition to that, in your AutoDopNetwork, you’ll find a new “Source Volume” node added to 
the flipsolver you chose. If you run your simulation, you’ll notice that the water particles will start 
draining into the object. 

 
NOTE: If you don’t see the particles draining, it may be that your sink object isn’t big 
enough. Jack up the size. 
 



NOTE: Notice that, just like for an emitter, a sink adds a Source Volume node. The 
difference (I guess) is how the node is set up. It’s probably set to kill particles that enter it 
vs generate particles from it. 

 
If you want to consume more water particles at once, you’ll have to scale up your sink object. 

Fluid Bounding Box 
The important thing with this is that FLIP fluids will be confined to a certain bounding box. If they 
go past the extent of the bounding box they will either disappear or collide (depends on your 
settings). 
 

 

Bounding Box Size 
To control the size of the bounding volume box, go to the flipsolver node. Under Volume Motion 
-> Volume Limits you’ll find the Box Size and Box Center properties… 

 



NOTE: You can also use the handle tool and change this directly in the scene view… 

 

Bounding Box Collision Behaviour 
To control whether particles collide or disappear when they hit the limits of the bounding box, 
you need to go to whatever FLIP object it is that’s being fed into the solver. Under the Properties 
tab, you’ll see an option called Closed Boundaries that’ll let you choose which parts of the box 
you want to treat as closed (collides with) or open (disappears when hit). 

 
 
If you choose to have them collide with the boundary, you can set it so that they force of the 
water doesn’t get reflected back when it hits that boundary by unchecking the Collide with 
Volume Limits checkbox in the flipsolver (under Particle Motion -> Behaviour)... 

 



Fluid Collisions with RBDs 
There doesn’t seem to be a foolproof way of having FLIP fluids properly interact with collision 
objects. Ultimately that means that if you’re trying to simulate an object floating on or inside the 
water, you’re going to have a tough time. The following sections are an overview of the possible 
techniques to deal with this. 

Feedback Scale, Density, and Collision/Particle Separation 
You can adjust how much ‘feedback’ the water gives to collision objects based on the Feedback 
Scale value in the flipsolver… 

 
 
In your solver, you can find the Feedback Scale slider under Volume Motion -> Solver. The 
Feedback Scale goes from 0 to 1, where 0 is 0% and 1 is 100%. I noticed that somewhere up 
high (around 0.9 or 1.0) is a good value. 

 
 
Once you do this, you’ll need to potentially tweak the density of your water and the RBD objects 
you throw in them. You can tweak the density of your water by going to Physical tab of your 
flipobject. This density value will interact with the density of your RBD object (and the feedback 
scale to determine) to determine if your object should float or sink or whatever. 



 
NOTE: You can find the density of your RBD object in the Properties tab of your RBD 
object. Remember that changing the density means that it’ll your mass is being modified, 
which means that you’ll potentially mess with other physics-related stuff. 

 
Once you do this, you may notice highly erratic behaviour in your simulation with the way the 
RBD objects react to fluids. There are a couple of things you can tweak under the Properties tab 
of the flipobject to help with this. 
 
The first is the Particle Separation value. A low Particle Separation value of your flipobject 
means more particles, which means a more accurate simulation (but also one that’s more 
computationally expensive). 
 
The second is the Collision Separation value. I don’t know exactly what this does, but enabling it 
seems to get rid of all the erratic behaviour without having to lower the Particle Separation 
value. 

 



Apply Artificial Force to RBD Object 
One option is to having your object interact with water would be to apply a force to the object to 
make it seem like the water is resisting it. For example, you can stick a Fan Force node after 
your RBD object to simulate buoyancy in the water. The water will still move around properly as 
the box goes up-and-down inside it, making it look realistic. 

   
 

NOTE: The fan is beneath the box. It’s being partially obstructed by the water particles. 
Remember the force that’s being applied to the RBD does not have an effect on the 
water. 

Embed In Fluid Tool 
One way to get your objects to interact with water would be to use the Embed in Fluid item 
under the Container Tools shelf. 

 
 
This is almost always NOT what you want. What it does is that it takes the POINTS of the object 
and embeds it alongside the FLIP fluid particles, causing your object to deform over time rather 



than interact with the water… 

 →   
 
Nevertheless, if you want to use this… 

1. make sure you have nothing selected 
2. click the shelf item 
3. select the object to embed and press Enter 

(you’ll be prompted in the scene view) 
4. select the flipobject in your AutoDopNetwork and press Enter 

(you’ll be prompted in the scene view to do this) 

Fluid Forces 

Particle Forces 
Remember that FLIP fluids are a combo of Houdini’s old volume-based fluids and particle-based 
fluids. As such, you can apply any of the POP forces to FLIP fluids. These forces get plugged 
into the second input of a fluid solver (the Particle Velocity input)… 

 
 

HINT: A common technique to create turbulent water is to connect a popwind and 
change up the noise amplitude and swirl… 



 
 
The following is the a copy of the forces section of the particles document. It gives an overview 
of the particle forces available. You can find these all under the Particles shelf or via the Tab 
menu search (search for “POP”)... 

 

 
 
There a ton of different forces you can apply to particles. It seems like these forces ONLY effect 
particles and nothing else. 
 

NOTE: The gravity node is applied to particles as well. If you don’t want it applied, you 
need to bypass it. Keep that in mind when applying these forces. 

 
For example, rigid body objects are not affected by these objects. The particles may change 
direction as a result of the force and hit the rigid body differently (causing the rigid body to move 
differently), but the force itself won’t move the rigid body. 
 
Here are the types of forces you can apply… 

● Axis Force → for spinny things like hurricanes/turbines/dust devils/etc.. 
● Wind/Drag → applies a constant force to particles regardless of location 
● Fan → Like Wind/Drag but applied to a certain area 
● Force → something akin to gravity? How’s this different than Wind/Drag? 
● Flock → flocking behaviour for particles 
● Curve Force → creates forces generated from a curve???? 
● Point/Curve Attract → attracts particles to point or curve 



 
NOTE: See the section on Collision w/ Non-Dynamics… Just like how the placement of 
the POP Collision Detect node is important, the placement of your force node is also 
important. If it’s after the final merge before the pop solver, it means all particles being 
fed into the popsolver will follow the force rules added by this node. If you only want 
these rules only applied to particles emitted from certain emitters, move it so that it’s in 
the path of those emitters (before the final merge). 

 

Volume Forces 
Remember that FLIP fluids are a combo of Houdini’s old volume-based fluids and particle-based 
fluids. As such, you can apply any of the volume forces to FLIP fluids. These forces get plugged 
into the third input of a fluid solver (the Volume Velocity input)… 

 
 
The easiest way to apply a volume force to an object is to use a Pump. You can do this by… 



1. create an object in your scene (e.g. sphere) 

 
2. make sure nothing is selected 
3. select the Pump from Object item in the Populate Containers tab 

 
4. select your object and press Enter 

(you’ll get a prompt to do so in the scene view) 
5. select the FLIP fluid object being fed into your flipsolver in the AutoDopNetwork and 

press Enter 
(you’ll get a prompt to do so in the scene view -- the prompt says gas instead of fluid, 
this is probably just a bug) 

6. your object should show up as mist now -- dive into it 
(this won’t show up in the final render + you can hide it in your scene view if you want -- 
it will still function) 

 



7. select the Fluid Source node and go to the Velocity Volume tab 

 
8. enable Add Velocity and punch in a force vector 

(red guides will show up in the scene view once you do this) 

 



9. fluids coming into this area will now have this force applied 

 

Fluid Accuracy 

Particles 
To control the accuracy of your FLIP fluid simulation, you can change the size of the particles 
that get generated. The more particles you have in your fluid simulation, the better it will look. It 
sounds like the more movement/collisions you have, the more particles you want. 
 
To set the particle size, you need to go to whatever FLIP object it is that’s being fed into the 
solver. Under the Properties tab, you’ll see an option called Particle Separation. The smaller this 
is, the more particles you’ll have. 

 
 
Obviously… the downside with doing this is that the more particles you have the longer it’ll take 
to compute. 



Collision Geometry 
You’ll notice a lot of times that your fluids will seep through objects instead of properly colliding 
with them. The reason for this is very likely because the objects your colliding with have bad 
collision geometry. 
 
If you’re dealing with rigid bodies or collision objects (e.g. ground object / terrain object / static 
object), you can use surface collisions instead of volume collisions to get better results. You can 
read the document on collisions for a detailed overview on this… 

 
 

NOTE: One other option to use (if you want) is to try to make your geometry thicker, that 
way the volume-based collision may have an easier time generating correct collision 
geo. 

Fluid Viscosity 
Enabling fluid viscosity manually isn’t a simple process. The flipsolver has a Enable Viscosity 
checkbox under Volume Motion -> Viscosity, but enabling just that does nothing. 

 



 
It turns out that there are a bunch of different places you have to enable viscosity to get it to 
actually function. There’s a handy item under Particle Fluids shelf that does this for you called 
Make Viscous… 

 
 
Make sure you have nothing selected and click it. In the scene view you’ll get prompted to select 
the FLIP Object(s) to make viscous and press Enter. Go into your AutoDopNetwork, select 
them, and hit Enter. 

 
 
You’ll get the following message box show up... 

 
 
Essentially all this is saying is that there’s 2 ways to set viscosity… 
 
If you want to have different particles be different viscosities, you need to add to the viscosity 
attribute to your particles. If you look at the geometry spreadsheet, you’ll see that the particles 



generated by your FLIP Object now each have a viscosity attribute of 1.0… 

 
NOTE: There is no node in the dynamics context to add to an attribute. You’ll have to do 
this via VEX, which I don’t know how to do yet. 

 
If you want all your fluids to have the same viscosity, you can use the Volume Motion -> 
Viscosity Tab of your flip solver… 

 
The more you jack up the Viscosity Scale value, you more viscose your fluid will be. For 
example, something like 10000 would represent honey. You can get it high enough to represent 
something like bread dough. 

NOTE: Remember from above that your fluid particles will have a viscosity of 1.0. Note 
the Mix Method -- what’s happening is that your viscosity attribute is being multiplied by 
the Viscosity Scale value you set. If they’re always defaulting to 1.0, you don’t have to 
worry. If they’re something else, you may want to use a different Mix Method. 

 



 
 







Houdini 16 Oceans 
 

Introduction 

Ocean Surface 
Create 

Setup Resolution 
Setup Render 
Setup Size 

Control 
Resolution 
Perfect Loops 
Wind 
Waves 

Shaders 

Fluid Tanks 
Create 

Setup Tank Size 
Setup Source/Sink Water Rate 
Setup Water Level 
Setup FLIP Fluid Details 

Whitewater 
Create 
Particle Guides 
Particle Properties 

Enable/Disable 
Foam 
Spray 
Bubbles 

Introduction 
Houdini’s Ocean tools (formerly called Ocean FX) are a set of tools to help artists with oceans. 
These tools are broken down into 2 main categories: 

1. Simulating the surface of an ocean 
2. Fluid tanks (very similar to a FLIP Tank) 

 
You can find them under the Oceans shelf. 



 
 

NOTE: Not 100% sure if these tools are actually used by most artists. This part of 
Houdini could be similar to Maya’s muscle system (in that no one uses it for anything). 

Ocean Surface 
You can simulate the surface of an ocean using the first 2 options in the Oceans shelf. 

 
 
This part of the document will focus on the “Small Ocean” item, but the “Large Ocean” item is 
probably very similar. 
 
The surfaces generated here ARE NOT CONTROLLED BY A DOPs NETWORK! They are 
entirely simulated on their own, and they can’t really interact with any other fluids or rigidbodies 
or anything else that requires a DOP setup. 

Create 
You can create a surface by using the Small Ocean item in the Oceans shelf. 

 
 
Once you do, you’ll end up getting what looks like a patch of terrain and 2 new nodes in your 
/obj context… 

 
● ocean_surface is the surface of your ocean 



● ocean_interior is the ‘inside’ of the ocean (essentially a volume extrude of the surface 
that’s hidden from the scene view but visible in renders) 

 
NOTE: Notice how there’s no AutoDopNetwork here. This is independent of DOPs and 
can’t interact with other physics as if it were a FLIP fluid. 

 
If you play your animation timeline now, you’ll see the ocean surface animating as if it were a 
real ocean’s surface. 

Setup Resolution 
Once you’ve created your ocean, you need to do one extra thing: you need to make sure that 
the grid that makes up the surface has enough quads for our ocean surface's “resolution”... 
 

1. Go into the ocean_surface node... 
2. Go to the oceanspectrum node (highlighted in image below)...

 
3. The first property you’ll see is Resolution Exponent. Right-click on the label and choose 

Copy Parameter... 

 
4. Go to the preview_grid node (highlighted in image below)... 

 



5. Right-click on the label for Rows property and choose Paste Relative References... 

 
6. The Rows property should now read ch("../oceanspectrum1/res"), change it to 

2^ch("../oceanspectrum1/res")... 

 
7. Repeat steps 5 and 6 for the Columns property 

 
 

NOTE: It’s unsure where the formula 2^exponentres came from, but that’s what the 
lesson recommended. With this, we can now make sure that if we jack up the surface 
simulation’s resolution, we’ll jack up the number of faces in our grid that the surface gets 
mapped to (so we end up seeing the extra detail). 

Setup Render 
Once you’ve created your ocean, you need to do one extra thing to get it to render properly: you 
need to feed the displacement map generated for the ocean’s surface into your render node so 
that you get a proper render. 
 

1. Go to the /out context -- a node should have been added by the Ocean tool called 
fetch_export_spectra (it controls the displacement map for the ocean surface)… 

 
2. Create your mantra node if you don’t have one already (make sure the renderer is set to 

Physically Based Rendering)... 

 



3. Hook the created node into your mantra node… 

 
 
Once you do this, you’ll get proper renders... 

 
 

NOTE: DO NOT USE THE RAY TRACE RENDERER. It seems to have problems and 
ends up dipping into the volume element that’s underneath the surface. 

Setup Size 
You can make the grid that makes up your ocean as large as you want. You can do so by going 
into your surface node (in the /obj context) and navigating to the render_grid node… 

 
 



Change the size of this grid to however large you want your surface to be… 

 
NOTE: Don’t worry about this node that being connected to anything. Other nodes in this 
network have a channel reference to the size here, so everything will just magically work 
once you set the new size. 

 
One thing you may notice after you do this… the waves are being tiled together (there’s an 
obvious pattern)... 

 
 
You can increase the size of the tile being generated (to make it less obvious) by going to the 
oceanspectrum node and increasing the Grid property… 

 

 
 
Here’s an example with a Grid Size property of 50/100/150 (this is for a 400x400 grid plane). 



 →   →   

Control 
You can gain control over the surface of your water by going inside the ocean_surface node and 
to the oceanspectrum1 node. In here, you can find lots of options that reference real-world 
properties… 

 

 

Resolution 
As discussed in the Create section, you can jack up the resolution of your surface via the 
Resolution Exponent and Grid Size properties… 



 
 

NOTE: All of this is predicated on PROPER SETUP. See the Create section and make 
sure you did all the setup properly. 

 
Resolution Exponent defines how detailed your surface is. The higher this number is, you can 
have smaller and smaller waves propagate over your surface, resulting in much finer/realistic 
detail. 
 
Grid Size defines the tile size for the surface of your ocean. So if you set up your ocean to be 
super large, Grid Size will control how much repetitiveness there is on the surface of your 
ocean. See the Setup Size section for more information. 

Perfect Loops 
You can make it so that the animation on the surface of your ocean loops perfectly via the Loop 
Over Time and Loop Period properties... 

 
 
If you check Loop Over Time, you can fill in the Loop Period value. Loop Period is the number of 
seconds before the animation should loop. 
 
So for example, if you have 240 frames in your animation and you set your FPS to 24 (these are 
the defaults), you want to set this to 10. 



Wind 
All wind related properties are under the Wind tab... 

 
 
Most of the properties here should be self-explanatory… 

● Direction and Speed refer to the wind being applied. 
● Directional Bias controls the amount of waves that “align” with the wind direction... how 

many of the waves being generated for the surface follow the direction property -- if this 
value is zero, your ocean won’t have a direction? each wave goes in its own direction? 

● Directional Movement dampens waves that are going against the wind -- 1.0 means all 
waves are going in the same direction, 0.0 means waves are going equally both in the 
direction of the wind and against the direction of the wind. 

● Cusp controls how rounded the peaks of your wave are -- in certain cases you’ll need to 
round your peaks because your peaks will be so sharp and high that they’ll protrude 
through themselves… here’s an example of the same wave using a high cusp value vs a 
low cusp value 

 →   



Waves 
All wave related properties are under the Amplitude tab... 

 
 
The big property here is Scale. The higher the scale is, the larger your waves will be. Don’t 
bother touching anything else. 
 

NOTE: The Min Wavelength option takes out waves that are smaller than a certain size. 
It’ll cause you to smooth out your water the higher it gets, almost as if you’re dropping 
the Resolution Exponent value. Unsure why this would ever be used? Maybe to get a 
cartoonish look to water? 

Shaders 
Remember that 2 geometry nodes got created for your ocean surface… 

 
 
ocean_surface is the top of your ocean, while ocean_interior is a murky volume that protrudes 
slightly underneath it. You can see both if you do a render… 



 
 
Each geometry node is controlled by a shader. You can use these shaders to customize how 
your water looks. 
 
To see which shaders are being used, go to the geometry node’s properties and check the 
Material property under the Render tab… 

 
HINT: Clicking the little arrow on the right will take you to the material node. 

 



 
 
The following is the material properties for the surface and interior. 
 
For oceansurface (the material for the surface geometry node), only stuff under Ocean Shader 
-> Waves seems to do something. Foam doesn’t seem to do anything anymore -- it seems to be 
totally ignored. 
 
For oceanvolume (the material for the interior geometry node), the Cloud Density property 
controls how murky the interior volume is. 

Fluid Tanks 
Fluid tanks are essentially FLIP Tanks (see the document on fluids) with some special stuff 
added to them such that they follow along with some animated object and create/sink particles 
as they move with that object. 
 
Every shelf item highlighted below (except for Whitewater) is a variation of the Flat Tank option, 
so that’s the one we’ll be focusing on. 



 
NOTE: Whitewater is used for generating realistic particles for foam/bubbles/etc.. as 
your object moves in the Flat tank. 

Create 
First, make sure you have an animated object in your scene. 
 
Select the object and choose the Flat Tank shelf item in the Oceans shelf… 

 
 
A tank of water particles should surround your object now. If you play your animation, the tank 
will follow along with your object and the water particles will react as if it is actually moving… 

 
 
4 new nodes should be added to your /obj context… 

 
● box_object1 is the original object the flat tank was added to. 

 
 



● flattank_sim is the DOP network that handles the fluid physics. 
 
This exactly like an AutoDOPNetwork, except that it’s focused entirely on the dynamics 
for the flattank and this object. Infact, if you go into this DOP network you’ll see that all it 
does is add the object as a static object and feeds the flattank into a flipsolver as if you 
created a FLIP Tank. If you really wanted to you can just move these items into your 
other DOP network (if you had one)... 

 
 
 

● flattank_fluid shows the particles in your scene view (exactly the same thing that 
happens when you create FLIP fluids from the Fluid Particles shelf) 
 
 

● flattank_fluidinterior is for rendering the water in your final render (exactly the same thing 
that happens when you create FLIP fluids from the Fluid Particles shelf) 
 
 

● flattank_initial contains the details of your tank 
 
 
To set the details on your tank, step into the flattank_initial node and then to the wavetank node. 



 

Setup Tank Size 
First, step into the flattank_initial node and then to the wavetank node (see end of parent 
section for more details). 
 
You can control your tank size by changing the Size property… 

 

Setup Source/Sink Water Rate 
First, step into the flattank_initial node and then to the wavetank node (see end of parent 
section for more details). 
 



You can control how many water particles your tank creates/eats as it moves by setting the 
boundary around your tank. This is under the Boundary Layer tab... 

 
NOTE: The inner box is the water used for the simulation, the outer box is the water 
that’s generated. You may need to increase the size of the outer box depending on how 
fast you’re moving because you’ll need to generate more water particles. 

Setup Water Level 
First, step into the flattank_initial node and then to the wavetank node (see end of parent 
section for more details). 
 
You can control how many water level in your tank by setting the Water Level property under 
the Particles tab.. 

 
NOTE: 0 means exactly the middle 



Setup FLIP Fluid Details 
You can set the details on the FLIP fluid by going into the flattank_sim DOP network and fiddling 
with the FLIP object and flipsolver. This was covered extensively in the Fluids document.  

 

Whitewater 
Whitewater controls the dynamics/physics of a flat tank’s foaming, spray, and bubbles as your 
object moves through it. 
 

NOTE: This only controls the movement of the particles. The actual shaders on those 
particles are myst sprites -- they look nothing like what they’re suppose to. 

 

Create 
First, make sure you have an nothing select in your scene. 
 
Select the object and choose the Whitewater shelf item in the Oceans shelf… 



 
 
Select your flat tank in your scene and press Enter (or go into the flattank_sim node in /obj and 
select the FLIP Object for the flat tank that’s being fed into the solver, then go back to your 
scene and press Enter). 
 
3 new nodes should be added to your /obj context… 

 
● whitewater_sim is the DOP network that handles the fluid physics. 

 
This exactly like an AutoDOPNetwork, except that it’s focused entirely on the dynamics 
for the whitewater. If you really wanted to you can just move these items into your flat 
tank’s DOP network (or maybe a larger DOP network if you had one). The only thing to 
be aware of is that THERE IS NO GRAVITY NODE HERE. 

 
 
 

● whitewater_import shows the particles in your scene view (copied over from the 
whitewater_sim DOP network). 
 
 



● whitewater_source is (I think) a copy of your flattank’s details that eventually get fed into 
the whitewater_sim network. 

Particle Guides 
If you want to colorize each particle by type (e.g. spray should be green, bubbles should be red, 
etc..), you can go to the whitewaterobject node inside the whitewater_sim DOP network. There’ll 
be a Guides tab with an option called Color Particles by Type… 

 
 
Here are colorized guides vs normal guides… 

 
 
Essentially these colorized guides just give you a quick idea of how things will look in your final 
render. 



Particle Properties 
You can go to the whitewatersolver node inside the whitewater_sim DOP network and find 3 
tabs that control the foam, spray, and bubble properties. 

 

Enable/Disable 
You can choose to enable or disable foam/spray/bubbles by going to the related tab and 
choosing the Enable (type) checkbox. 

 

Foam 
Foam particles sit on the surface of the fluid. Foam particles are primarily affected by the 
movement of the water and your object. You can control foam by going to the Foam tab… 



 
 
Obviously, stuff under the Lifespan tab controls the lifespan of the particles and stuff under the 
behaviour tab controls the behaviour of the particles. 
 
There are 2 important attributes here… 

1. Advection Strength (under Behaviour) 
This controls the motion of foam particles. The higher the advection strength, the more 
that the foam bubbles will move with the fluid. 

 
 

2. Preserve Foam (under Lifespan) 
This overrides the minimum lifespan you set in Min Lifespan if the foam is part of a large 
clump of foam. The size of the clump and how much time is added to the lifespan is 



determined by the parameters below the Preserve Foam checkbox. 

 

Spray 
Spray particles live above the fluid. Spray particles are primarily affected by the force of gravity. 
You can control spray by going to the Spray tab… 

 
 
Obviously, stuff lifespan attributes controls the lifespan of the gravity is the force of gravity. 
 

NOTE: This solver is not feeding into a gravity node. It’s applying its own gravity locally. 
If you had this inside of a DOP network with gravity, you would likely need to make links 
between the gravity node and this. 

 
The important property here is Drag. The higher drag is set, the more narrowed those spray 
particles will be. Here’s an example of 0 drag vs a drag of 2 for a relatively fast moving object… 



 
 
It’s almost as if the particles are being dragged back, which is I guess what you want. The spray 
particles are probably not taking into account how fast your object is moving since your object’s 
movement is relative to the flat tank. The drag simulates the particles staying in place as your 
object is moving forward (instead what’s happening is that the particles are being dragged back 
and your object is staying in place -- ultimately the end result is the same). 

Bubbles 
Bubble particles live below the fluid. Bubble particles are primarily affected by bouyance (this is 
a property you set on the solver). You can control bubbles by going to the Bubbles tab… 

 
 

HINT: Bubbles are only visible underneath the surface of the water. If you’re going to 
have a murky style water shader (e.g. swamp?), you can save yourself some simulation 
time by disabling bubbles completely. 

 



Obviously, lifespan attributes controls the lifespan. 
 
The important properties here are Advection Strength and Buoyancy. 
 

1. Advection strength controls how the bubbles move with the water (just like foam) -- the 
higher the advection strength, the more that the bubbles will move with the fluid instead 
of scattering. 

2. Buoyancy is how fast the bubbles come up -- the higher the buoyancy, the faster they 
come up? 

 
Here’s an example of a buoyancy of 0,0,0 vs a buoyancy of 0,3,0… 

 
NOTE: The actual amount of influence that buoyancy has diminishes significantly as the 
object moves faster and faster. The example above was a very slow moving object. For 
a fast moving object, I couldn’t tell the difference between 0,3,0 and 3000,3000,3000. 
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Introduction 
This physics portion of Houdini is called dynamics. There’s a ton of different things you can do 
with dynamics, but this text is specifically about particles. You can think of particles as 
points/objects with no volume. When bound to sprites, they can be used to to simulate things 
like snow, rain, smoke, dust, etc… 
 
Like all dynamics, particles have friction, bounce, and velocity attributes. Maybe mass/density 
attributes as well? 
 
The shorthand for dynamics is DOPs (Dynamic OPerators). Particles seem to work under the 
dynamics portion of Houdini, but I’ve also seen them get called their own thing: POPs (Particle 
OPerators)? 

Scene Scale and Dynamics 
See the following section of the Houdini 16 Collisions document: Scene Scale, Dynamics 
Networks, and Dynamics Playback. 
 
Not going to repeat those sections here -- all of them still apply. 



Particle Emitters 
You can emit particles either from a point or from faces of a geometry. 
 
To emit from a point, use Location Particle Emitter from the Particles shelf… 

 
 
To emit from a set of polygons, select your geometry and use the Source Particle Emitter from 
the Particles shelf… 

 
 
Regardless of which one you use, you’ll get an AutoDopNetwork at /obj level. 
 

NOTE: If you don’t remember, an AutoDopNetwork is a dynamics network that Houdini 
creates for you when you first use dynamics / adds to as you use more dynamics. 

 
Inside the AutoDopNetwork, you’ll see your particle emitters along with a popobject node being 
fed into a POP solver (Particle OPerator solver). 



 
 
Here’s what the DOP network setup means… 

● POP Location controls particles coming out of a Location Particle Emitter 
● POP Source controls particles coming out of a Source Particle Emitter 
● POP Object makes the particles being generated interactable with other stuff in the 

dynamics -- e.g. collision with rigid bodies 
● POP Solver performs the physics computations for the generated particles 
● Gravity is what applies gravity (part of any AutoDopNetwork, not specific to particles) 

 
The Location Particle Emitter and the Source Particle Emitter both have the same set of 
properties for how particles are generated. To access them, traverse into the AutoDopNetwork 
and select the node for whichever emitter it was you created (either POP Location or POP 
Source)... 

 



Location 
If you used a Location Particle Emitter (POP Location), you can control which point the particles 
are generated from via the Position property… 

 
 
If you used a Source Particle Emitter (POP Source), you can control which faces the particles 
are generated from via the Source tab... 

 
SOP is a reference to the geometry object, and Source Group is a reference to a group in that 
geometry (if empty selects the entire geometry). 
 

NOTE: By default it looks like particles are generated at random across the geo. You can 
try fiddling with the Emission Type dropdown to change this. 

Creation/Destruction 
You can control when/where particles are created and destroyed via the Birth tab… 



 
 
Impulse Act/Count * Activation is a on/off value (0 off, anything else = 1) that determines if 

this feature is enabled. 
* Count is the number of particles to generate per frame. 
 
NOTE: It says each time the node cooks… nodes cook per frame, right? 
 
NOTE: This CAN be used along side Const. Activation / Birth Rate 

 
Const Act/Birth Rate * Activation is a on/off value (0 off, anything else = 1) that determines if 

this feature is enabled. 
* Count is the number of particles to generate per second. 
 
NOTE: It doesn’t generate all the nodes at the start of each second. 
Instead it generates the relevant amount at each frame. So if our 
playback was set to 24 FPS and our count was set to 5000, each frame 
we’d get 5000/24 particles. 
 
NOTE: This CAN be used along side Impulse Activation / Count 

 
Seed Seed for random number generator used for determining where particles 

show up. 
 
Life Expectancy How long each particle lives (in seconds). 
 
Life Variance How much to vary the Life Expectancy value. 

 



For example, if this was set to 5, the life expectancy would have a 
random number added to it ranging from -5 to 5. 

Initial State 
You can control the initial state of your particles via the Attributes tab… 

 
 
Velocity The initial velocity of the particles being generated 
 
Variance How much to vary the velocity value. 
 

NOTE: What about the Initial/Inherit fields? These fields are only available if you’re using 
a Source Particle Emitter (if you’re generating your source from geometry). I think what 
it’s for is if the geometry you’re generating particles on is also a dynamics object (e.g. 
rigid body), its velocity and stuff will be mixed into the velocity of the particles being 
generated.  

 
For example, if you had a velocity of (10, 0, 0) and a variance of (0, 0, 0), your particles would 
shoot down the X-axis like a straight line… 

 

 
NOTE: Why is it dropping in steps instead of gradually? Probably because the FPS is 
higher than the physics iterations per second? 

 
For example, if you had a velocity of (10, 0, 0) and a variance of (1, 1, 1), your particles would 
shoot down the X-axis like a straight line but each particle would vary its velocity in each axis by 



a random value from -1 to 1… 

 

 

Particle Collisions 

Collisions w/ Dynamics 
By default, collisions will interact with rigidbody objects and collision objects. They won’t interact 
with each other though. 
 

NOTE: If you want particles to interact with each other, check out RBD Grains under the 
rigid body shelf… 

 
 
Particles don’t seem to have a mass or volume associated with them. People on reddit say that 
the solver assigns some default mass/volume for each particle in order to calculate things like 
bounce and friction (I’m guessing mass/volume is required for these calculations).  
 

NOTE: Remember that collision objects include: ground planes, static objects, etc.. -- 
basically anything from the Collisions shelf / anything being fed into a static solver. 

  
The physical/collision details of the particles can be found under the popobject being fed into the 
particle solver in the AutoDopNetwork. If you select it, in the properties pane you’ll find a 
Collisions tab and a Physical  tab... 

 



 
 
Tolerance defines how close the particle has to be to the object to consider it collided? Since 
there is no volume for a particle (I think), it’s calculated as a ray? 
 
Volume Offset defines how much volumes are pushed out by a particle when they collide? Does 
volume here mean volumetrics (e.g. fog) or any object with a volume???? 
 
Bounce and Friction should be obvious. The rest I’m not too sure about. 
 

NOTE: Popobject is where particles are generated. Check out the geometry spreadsheet 
when in the AutoDopNetwork and select popobject -> Geometry. 

Collisions w/ Non-Dynamics 
If you want to collide with a shape that isn’t a dynamic (hasn’t been added in as a rigid body or a 
static object or a ground plane or anything like that), you need to use the Collision Detect 
Particles item in the Particles shelf (it’s near the end of the shelf)... 

 
 
Once you do this, it adds POP Collision Detect node between your particles and the popsolver. 
In here you can adjust what happens on collision in the Collision tab via the Response 
dropdown (your options are slide/stick/die/stop -- all pretty self-explanatory). 



 

 
 

NOTE: The shape that the collision is being applied to is under the Collision tab. 
 



NOTE: Notice where the POP Collision Detect node was generated. It’s after the merge, 
which means all particles being fed into the popsolver will follow the collision detect rules 
added by this node. If you only want these rules only applied to particles emitted from 
certain emitters, move it so that it’s in the path of those emitters (before the final merge). 

 

Particle Forces 
There a ton of different forces you can apply to particles. It seems like these forces ONLY effect 
particles and nothing else. 
 

NOTE: The gravity node is applied to particles as well. If you don’t want it applied, you 
need to bypass it. Keep that in mind when applying these forces. 

 
For example, rigid body objects are not affected by these objects. The particles may change 
direction as a result of the force and hit the rigid body differently (causing the rigid body to move 
differently), but the force itself won’t move the rigid body. 
 
Here are the types of forces you can apply… 

● Axis Force → for spinny things like hurricanes/turbines/dust devils/etc.. 
● Wind/Drag → applies a constant force to particles regardless of location 
● Fan → Like Wind/Drag but applied to a certain area 
● Force → something akin to gravity? How’s this different than Wind/Drag? 
● Flock → flocking behaviour for particles 
● Curve Force → creates forces generated from a curve???? 
● Point/Curve Attract → attracts particles to point or curve 

 
NOTE: See the section on Collision w/ Non-Dynamics… Just like how the placement of 
the POP Collision Detect node is important, the placement of your force node is also 
important. If it’s after the final merge before the pop solver, it means all particles being 
fed into the popsolver will follow the force rules added by this node. If you only want 
these rules only applied to particles emitted from certain emitters, move it so that it’s in 



the path of those emitters (before the final merge). 

 

Particle Sprites 
Sprites are textures that are attached to particles in billboard style. 
 

NOTE: Billboarding means that it’s a flat 2d texture that always faces the camera. No 
matter how you orient the camera, you’re always looking at the picture head-on. See 
https://gamedev.stackexchange.com/q/54871 

 
You can apply sprites to particles via Sprite Particles options of the Particles tab. Once you do, 
you’ll get a POP Sprite node in your AutoDopNetwork. 

 
 

NOTE: See the section on Collision w/ Non-Dynamics… Just like how the placement of 
the POP Collision Detect node is important, the placement of your POP Sprite node is 
also important. If it’s after the final merge before the popsolver, it means all particles 
being fed into the popsolver will have sprites applied. If you only want sprites applied to 
particles emitted from certain emitters, move it so that it’s in the path of those emitters 
(before the final merge). 

https://gamedev.stackexchange.com/q/54871


 
The two important tabs in the popsprite node’s properties are Texture and Alpha. Texture lets 
you define the particulars of the texture displayed, while Alpha lets you control how the sprite 
fades away (or fades in)... 

 
 
Everything here should be pretty self-explanatory. Sprite SHOP/Map refers to the material to 
apply to the sprite. Texture Offset/Size is for things like tilesets. Rotate/Scale is for rotation and 
scale. Alpha Type controls how much alpha is applied at which point.  
 

NOTE: An important part of the lessons was using VEX to programmatically control 
some of these values. I’m going to skip this for now as it’ll probably be covered more in 
depth in later lessons. 
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Introduction 
Hair/fur in Houdini is done by through the concept of guide hairs. Guide hairs give detail on a 
particular cluster of hairs (e.g. length, shape, etc..), then when you actually do a render the real 
hairs show up modelled around those guide hairs. 
 
All hair functionality is provided via 3 shelfs: Hair Utils, Guide Process, and Guide Brushes. You 
can find these in the shelves in the first shelf-set of the Build desktop… 

 

 



 

Creating Hair 
To create hair, use Add Fur in the Hair Utils shelf. 

 
 
Once you do this… 

1. The scene view will prompt you to select an object and press Enter 
(only happens if nothing already selected when you clicked Add Fur). 

2. The scene view will prompt you to select an object for “animated skin” and press Enter 
(you can just press enter without selecting anything -- don’t know what this is) 

 
You’ll notice 2 things… 

● Fur will show up on your entire object 

 
● There are 2 new nodes in /obj: a Guide Groom node and a Hair Generation node 

 
 
The Guide Groom node is used for the hair guides and the Hair Generation node is what 
renders the actual hair. You do all your styling on the Guide Groom node, and the Hair 
Generation node will use those guides when it generates the hairs. 
 

NOTE: If you want to have only a specific group on your object have hair, select the 
Guide Groom node and choose the group you want to specifically target. 

 



Remember that you don’t need to specifically target a group. You can use the little arrow 
next to the dropdown to select random polygons directly in the sceneview. 

Hair Spread and Density 
Hairs are distributed based on the guide hairs. You can set how many guide hairs you have via 
the Density property of the Guide Groom node (under the Basic tab)... 

 
 
Here’s an example of a density of 1000 vs 100… 

 
 
Notice how it becomes super obvious how the hairs cluster around guide hairs once the hair 
density drops. We can have a low guide hair density if we want, we just need to go into the Hair 



Generator node and jack up the Influence Radius and Density under the Basic tab… 

 
 
For example, here’s a guide hair density of 100, but with a large influence radius (0.15) and a 
high density (132290)... 

 
 
 

NOTE: The hairs are being generated on top of the sphere only because the groom 
node’s targeting the top polygons only… 

 
If you look closely at the images of hair above, you’ll see that the guide hairs (yellow 
lines) are on these polys but the actual rendered hair is bleeding out to the rest of the 
polys below it. 
 
The only way to stop this is to explicitly DELETE all the polygons that hair shouldn’t be 
on. One trick is to simply create a copy of an object and only keep the polys that should 
have hair. Generate hair on that new object and hide the object from your scene. The 
hair will stay and it’ll be confined to those polys 



Hair Length 
You can control the length of your hair by going to the Length property of the Guide Groom 
node (under the Basic tab)... 

 
 

NOTE: This is the initial length of your hair. You’ll likely either cut or extend it further 
down in your workflow as you stylize it. How to do that is discussed in later sections. 

Hair Thickness 
You can control how thick your hairs are (both overall and in certain areas) by going to the 
Thickness tab of the Hair Generator node… 

   
 
It should be fairly straight forward what’s happening here. The thickness is the overall thickness, 
and the ramp controls how that thickness grows/shrinks over the length of the hair. 

Procedural Styling 
You can stylize your guide hairs procedurally by using the items in the Guide Processing shelf… 



 
 
Most of what the items do should be self-explanatory. Remember that Houdini has a node 
based procedural workflow. As you use these items, they’ll get added as nodes inside the Guide 
Groom node. 
 
For example, here’s what a Frizz + lengthen would look like inside the Guide Groom node… 

 
 
You can do all the stuff you would normally do with nodes here: reorder, manually add more in, 
bypass, etc.. 
 

NOTE: Most all the options in this Guide Processing shelf translate to a Guide Process 
node being added in (most… not all). Guide Process nodes have a Operation dropdown 
where you can select what you want them to do (the options in the shelf). You can even 
add more than one operation together here if you really wanted to… 

 
 
 
NOTE: If you’re doing renders inside the renderview, as you add/change these nodes 



the refresh/auto-update won’t pick up the new hair geometry. You need to explicitly hit 
the Render button if your hair geo changes… 

 
Not sure if something similar required if rendering to MPlay. 

Frizz 
You can add frizz to your guide hairs via Frizz… 

 

 
 
The main property here is amplitude. The higher the amplitude is, the more noise (aka frizz) is 
added to the guide hair… 

 
 
Remember that this operation is happening on the guide hair. If you have too few guide hairs, 
the entire thing will look off. It’ll look like clusters/hunks of hair are bending randomly, as if 



someone stylized the hair to make it look like a “bedhead” look… 

 

Smooth 
You can smooth your guide hairs via smooth… 

 

 
 

NOTE: The example above has frizz applied before smooth. Note that it’s almost back to 
being uniformly straight. 

 
The main property here is number of neighbours. The higher this value is, the more 
neighbouring guide hairs are brought into the averaging calculations to create a smoothed hair 
(I think)… 

 



Straighten 
You can straighten your guide hairs via Straighten… 

 

 
 

NOTE: The example above has frizz applied before straighten. 
 
I honestly have no idea how this is suppose to work. There are 2 properties here: Normal 
Straighten and Tangential Straighten. No idea what they’re suppose to do... 

 

Set Length 
You can grow/shrink your guide hairs via Set Length… 

 

 →   
 



NOTE: The example above has frizz+smooth applied. Note that when we shorten the 
length, the hair pretty much truncates (as expected). But, when we grow the hair, it pretty 
much grows straight out in the direction it was before the growth. 

 
The important property here is Length, which I think is the overall length of the hair. You can 
change the Mode dropdown if you want to do things like offset the hair length instead of setting 
it directly... 

 

Bend 
You can bend your guide hairs via Bend… 

 

 →   
 
This bends the hair such that its new endpoint is x degrees different from the previous endpoint. 
The important property here is Angle and Random Angle, which controls how much of an angle 



you want to bend by + how much randomness you want in that angle for each guide hair. 

 
 

NOTE: It doesn’t look like you can control the ultimate direction in which the bend is 
applied. 

Clump 
You can clump your guide hairs together via Clump… 

 

 
 
Clump does not get added as a Guide Processing node, but as its own node type (Hair Clump). 
 
The important property here is Clump Size, which technically will define how many clumps you’ll 
have (based on the number of guide hairs you have). But, there are also a ton of other options 
here. For example, you can curl your clumps if you want to, or you can use a ramp to set the 



thickness of your clumps in different areas... 

 

Manual Styling 
You can stylize your guide hairs manually (via the scene view) by using the items in the Guide 
Brushes shelf… 

 
 
Once you select any of these (don’t know about the first 2), your handle in the scene view 
should turn into a circular brush tool + you should get an internal Guide Groom node added to 
your top-level Guide Groom node. 

 
 
Your scene view’s toolbar should now also have a dropdown that’ll let you specifically select 
which tool you want to use… 



 
NOTE: These options are exactly what’s in the Guide Brushes shelf. You can manually 
switch here as you’re making changes to your hair. 

 
From here you can use the brush tool to pretty much change anything however you see fit: cut 
pieces of hair, extened pieces of hair, clump, brush, etc.. 

NOTE: It may be better to do this in 4-panel orthographic view. Depending on how many 
guide hairs you have, it may be difficult to target an individual hair. You might have to 
zoom in a lot to isolate which kind of defeats the concept of brushing.  

 
You can change the brush size, brush strength, and undo all your strokes in the properties of 
the Guide Groom node added for these changes. You may get more/less options depending on 
the Tool you’re using (e.g. brush, extend, cut, clump, …)... 

 
 

NOTE: Remember that you can undo individual steps with Ctrl+Z. Also you can use the 
mouse wheel in the scene view to increase/decrease brush size. 
 
NOTE: The lift parameter is also important. It controls an artificial buoyancy for the hair 
as you’re manipulating it… such that if you were to brush it down, it wouldn’t go exactly 



flat The hair would have some bounce back to it (unless maybe if you wanted to act as if 
it were being weighed down with something like hair gel). 
 
NOTE: If you’re doing renders inside the renderview, as you add/change these nodes 
the refresh/auto-update won’t pick up the new hair geometry. You need to explicitly hit 
the Render button if your hair geo changes… 

 
Not sure if something similar required if rendering to MPlay. 

Dynamics/Physics 
This section was not covered in the lessons, but it looks like you can enable physics for hair by 
using Simulate under the Hair Utils shelf… 

 
 
Doing this does not do the same thing as creating a collision object (e.g. ground plane) or a rigid 
body. YOU WILL NOT GET STUFF ADDED TO AN AutoDopNetwork NODE. Instead what will 
happen is that you’ll get a new Guide Simulate node… 

 
 
In this Guide Simulate node’s parameters, you’ll get a button to create a DOP network for this 
piece of hair. If you choose the button, a new DOP network will be created and referenced. You 
can go into that DOP network and cut/paste the contents it to your own DOP network + update 



the Guide DOP Object path. 

 
NOTE: There’s also a Simulation and Collision tab in the Guide Simulation node that 
defines how your guide hairs will react/collide with other stuff. There’s too much to go 
into detail here and none of it was talked about in the lesson. 

 
Once you do that, the hair should be able to interface with other dynamics in your system 
(particles, collisions, etc.. etc..). 

Rendering 
If you’re doing renders inside the renderview, as you add/change these nodes the 
refresh/auto-update won’t pick up the new hair geometry. You need to explicitly hit the Render 
button if your hair geo changes… 

 
 
Not sure if something similar required if rendering to MPlay. 



Hair Shader 
NOTE: If your hair geometry changes, you need to hit the Render button. But, if all 
you’re doing is messing around with the hair shader, you don’t need to do this. See the 
main Rendering section above if you’re confused. 

 
The Hair Geometry node contains a path reference to which material will be used to render 
whatever hair it’s generating… 

 
NOTE: You can use the second to last button (curved arrow) to go directly to the shader. 

 
The shader here is of type Hair Shader, and you can pretty much modify the properties here to 
get your hair to look however you want it to look. There are multiple tabs here… 

 
 

● Primary Reflection 
 
This defines the primary color of the hair. You can set a tip color vs a root color and 
control how they transition with the provided ramp. 
 

● Secondary Reflection 
 
This is like the specular. You’ll notice that by default the hair shader gives off this horrible 
sheen as if the individual hairs hasve been coated in wax. This is where that sheen is 
coming from. You can turn off the entire thing via the Enable checkbox at the top of just 
lower the intensity. 
 

● Transmission Color 
 
This is for “light passing through the hair”. Unsure if this is the same thing as a 
transmittance color in Arnold, which is… “Like color, but tints the object more as the ray 



goes through the object. Thin parts of the object get less tint while thicker parts get more 
tint.” 
 
So maybe the hair thickness attribute has an effect on the output for this??? I tried 
playing with the values but I couldn’t get it to show any difference. 
 

● Randomness 
 
Allows you to Randomize the HSV values of the diffuse (Primary Reflection) in addition 
to randomizing the specular. So the hair can technically be more varied in terms of 
brightness/darkness or color. 

Motion Blur 
By default, your Hair Geometry will not support motion blurring. If you want motion blurring to be 
enabled, go to your Hair Generate node. In the properties, there will be a Render tab. Under 
that tab there’s tab called Sampling. 
 
Turn on the Geometry Velocity Blur checkbox. 

 

Render Quality 
Once you start rendering, you’ll notice areas with sparse amount of hairs (e.g. the tips of the 
hair where it tapers off) have a lot of noise. You need to bump the rendering pixel samples to 
get rid of the noise. 
 
See the Render Quality section of the Mantra Rendering document to see how to do this. 
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Renders 
The renderer that comes with Houdini is called Mantra. It seems very similar to Maya’s Arnold 
renderer, but not as popular. Although Arnold does have a Houdini plugin, I think Houdini people 
prefer to avoid it when doing their FX work. 

Setup 
To setup the a render using Mantra, you need to create a render camera and add a Mantra 
render node in the /out context. 



Create a Render Camera 
Before you can render, you need to create a camera. To create a camera, you can either use 
the Camera item in the Lighting shelf… 

 
NOTE: Remember that if you hold Ctrl and click it’ll dump it at (0,0,0) and select it upon 
creation. 

 
Or, you can orient your scene to where you want your camera to be and in the upper right-most 
dropdown (just below the toolbar) in the scene view, choose New Camera… 

 
 
Once the camera is created, you can do a Maya “look-through object”-style orientation by… 

1. Selecting it in that same dropdown (doesn’t matter how you created it -- it’ll exist in the 
dropdown) 

 
 

2. Locking your view to the camera using the right toolbar 

 
 

3. Orienting your view using the normal pan/tumble/zoom controls 
 



 
NOTE: Remember to unlock your view once you’re finished orienting your camera. 
 
NOTE: You can set things like aperture and f-stop directly on the camera you created. 
All those options will be in the properties pane. 

Create a Render Node 
You can create render nodes in the /out context. Usually having 1 is fine, but you can create 
different render nodes if you want to have multiple different render setups (e.g. quick render vs 
production-quality render). 
 
You can add a Mantra node by going to the network view, switching context to out, and inserting 
a Mantra node from the Tab menu… 

 
 
After you set down the node, YOU MUST SET A CAMERA in the properties pane. That means 
your scene NEEDS to have at least 1 camera node in it... 

 
NOTE: See the above section on how to create cameras if you don’t have one created 
yet. 

 
It’s recommended by Houding to set the Rendering Engine to Physically Based Rendering. 
According to the lesson, this isn’t the default but the other methods are legacy and PBR gives 
you a lot of features out-of-the-box for free without manual tuning. 



 

Render Resolution 
You can set the render resolution on the camera that your Mantra node is linked to. In the 
camera properties, under the View tab there should be a Resolution property… 

 
 
You can scale down the rendering resolution of the camera in the Mantra node via the 
Resolution Scale in the property. To enable it, you need to check Override Camera Resolution 
property… 

 

Render Quality 
You can set the samples for the render (just like you do with Arnold). You can do so under 
Rendering -> Sampling in the properties pane of the Mantra node... 



 
 
Pixel Samples seems to be the most important option here. For things like subsurface 
scattering, if you don’t want a lot of noise you need to jack this value high. I set it to around 20 
or 30 to get a okay quality subsurface scattering. There are also individual “quality” sliders 
below Pixel Samples for things like SSS and specular. 

Image Planes (AOVs) 
Mantra’s equivalent of Arnold’s AOVs is called image planes. You can define image planes in 
the Mantra node by selecting what you want via the properties under Images -> Extra Image 
Planes… 
 

NOTE: Make sure you set your Output Device to OpenEXR. 



 
 
Once selected, YOU MUST RENDER TO MPLAY to see the AOVs… You can select which 
AOV is being shown via the dropdown in the toolbar. 
 

NOTE: C is the beauty render… To figure out what the rest of the codes are, look at the 
names of the checkboxes you selected for extra image planes. 

 

Standalone Render 
There are many ways to trigger a render… 
 



1. In the main menu… Render -> Render -> (mantra node name) 
 

2. In the main menu… Render -> Preview in MPlay  -> (mantra node name) 

 
 

3. In the left toolbar of scene view… click the movie reel (last button in the toolbar) and 
choose the render node name 

 
 

4. In the Mantra node itself, there are the following options available at the very top of the 
properties pane… 

 
If you choose Render to Disk, you can kill the Render by going to the Render View panel 
and choosing the Stop button… 

 
 
 

NOTE: MPlay is Houdini’s version of Maya’s fcheck? Fcheck is the Maya image 
playback viewer checker thing. You need to render to MPlay if you have extra image 
planes being output (image planes are the equivalent of Arnold AOVs) -- this is detailed 
in further sections 
 
NOTE: It turns out as your render’s happening, you can tell MPlay/Mantra to focus on a 
particular part first by clicking on it during the render. The tiles should start to focus on 



that area. This may only work if progressive rendering is turned OFF (double check this 
when you have a chance) 

Interactive Render 
Remember that IPR stands for Interactive Photorealistic Render. It’s used to get feedback on 
how the render looks in real-time. It’s works like downloading old school progressive scan 
JPEGs from the Internet back in the days of 56k modems. 
 
There are 2 ways to do IPR rendering: directly in the Scene View or via the Render View. 

Scene View 
You can do IPR on a select part of your scene through the scene view via the Render Region 
feature. 
 
To activate a render region… 
 

1. Select render region button on the left-hand toolbar (it’s near the bottom). 
2. Once selected, you can click-and-drag on a region in your scene view -- that region will 

render directly in the scene view. 
3. Notice how you get the exact same toolbar showing as you do in the Render View 



 
The render region has a little progress bar on top of it that fills up as the render completes. You 
can click the X in the righthand side of the progress bar to kill the render region. 
 
The toolbar will remain visible so long as the Render Region button is selected. If you want to 
know the particulars of the toolbar, check out the Render View section directly below (its the 
same toolbar). 
 

NOTE: Remember that if you can still manipulate your view while the Render Region is 
going. Use the shortcuts -- Space+LMB/MMB/RMB to rotate/pan/zoom. 

Render View 
You can do IPR through the Render View. The best way to set this up is to create a new floating 
window and set it to be a Render View. You can do this by… 
 



1. In the main menu, select Windows -> New Floating Panel 

 
 

2. In the new floating panel, right-click the top-level tab (there should only be one) and set it 
to Render View 

 
 

3. Make sure the proper Mantra node and Camera are selected in the toolbar 

 
 

4. Make sure that Auto-Update and Progressive Rendering are select in the toolbar 

 
 

5. Click the Render button 

 
 
 
If at any point you want to STOP a render, hit the Stop button in the toolbar. Hitting this button 
will also stop renders from happening when something’s updated. 
 
If at any point you want to PAUSE a render, hit the Pause button in the toolbar. Pausing just 
pauses the render mid-stream -- you can continue it from the point it paused by hitting hte 
pause button again. 



Gamma Correction 
You can set gamma the same way both in the render view and the MPlay. Right click on the 
render and select Color Correction… 

 
 
I don’t know what’s wrong with Houdini but it keeps defaulting the gamma to 1 instead of 2.2. If 
you click the icon it should automatically set to 2.2. It’ll get reverted back the next time you 
render. 

Materials 
NOTE: This section was adapted from the main document. It isn’t worth adding further 
detail in here because most of the lessons focused on legacy shaders within 
Mantra/Houdini. Also, this isn’t a renderer anyone uses for anything, so going in depth 
would be a waste of time. Much of the material stuff is pretty close to Blender/Arnold’s 
material stuff. 

 
Materials in Houdini 16 are handled in the /mat context (Materials) instead of the /shop context 
(SHader OPerations). The /shop context is still there but I’m not sure what it’s used for. 
 
If you try to pull in any of the default materials via the Materials pane, they aren’t allowed to go 
into a /shop context. But, if opening up legacy Houdini files all the materials are still in the /shop 
context. 

Create Materials 
You can create materials in the /mat context or via the Material’s palette. 



Materials Palette View 
You can create materials by going to the Materials Palette view (in the same section as the 
network view when under the Build desktop). 

 
 
You can select from the left pane, and move over to the right pane by pressing the right arrow or 
by dragging-and-dropping over. These create the materials for you under the /mat namespace, 
which you can navigate to in the network view and tweak as you see fit. 
 

NOTE: If you look at bottom left-hand side of right pane, you can see /shop. But,the 
Materials Palette won’t let you move stuff into the /shop namespace. I think the reason 
for this is that can be moved over is technically a Principled Shader, which can only 
appear under the /mat context. 

 
A discussion on materials is outside the scope of this document, but these are all Principled 
Shader (can you load in custom shaders that aren’t principled shaders???). Principled shaders 
are similar to Maya Arnold’s shaders or Blender’s principled shader: sub-surface scattering, 
specular, reflectivity, diffuse, etc.. -- all the stuff that makes it easy for artists to make materials. 

Network View (/mat Context) 
In the network view, you can switch to the /mat context and drop in Principled Shader nodes. If 
you want, you can also use the legacy Classic Shader here (called the Mantra Surface Shader 
in older versions of Houdini)... 
 



 
 
If you notice, the interface here is very similar to Maya’s hypershade instead of other networks 
inside of Houdini (e.g. dynamics or geometry networks). You can do things here like drop in 
perlin noise nodes and plug the output to the diffuse or specular. 
 

NOTE: Note the 3 small buttons on the bottom of the nodes… these are exactly the 
same as Maya’s buttons to collapse/expand nodes. 

Assign Materials 
The following subsections describe how to assign materials. 
 
You can technically drag-and-drop the material from the Network View /mat context or the 
Material Palette view onto the object in the Scene view to assign a material, but that seems to 
not work a lot of the times. 
 
If it does work, when you drop you’ll be prompted with a dropdown that asks if you want to drop 
on the object or one of the groups within the object (if you dropped on a group?). 

Partial Object (Groups within Object) 
NOTE: Need a refresher on groups? Check out the main Houdini document. 

 
It’s fairly straight-forward what to do with the Material node. Go into the Network view, into your 
geometry object, drop a Material node, and hook your geometry into it… 

 



 
In the parameters pane, choose the components which you want the color to apply to. You can 
do so by clicking the arrow on the right of the Group. Once you’ve done that, select the material 
you want to use by clicking the right-most button next to Material (will open a selection menu of 
materials under /mat). 

 
 
Note that you aren’t limited to one material. You can add multiple materials for different parts of 
the geo. In the example above, we have 3 different materials being added to 3 different parts of 
the geo. 
 

NOTE: You typically would have these groups pre-defined via group nodes (especially 
for materials). See the Group Nodes section for more information. 
 
NOTE: If you click the arrow never to Group, it’ll actually ask for a grouping rather than 
let you put in arbitrary components. You can turn this off by disabling the group selection 
toggle. You need to do this every time for Material nodes… 

 

Full Object 
In the network view (in the top-level /obj context), select the geometry object you want to apply 
the material to. 
 
Simply go to the Material tab in the properties pane and select the material… 

 



 
NOTE: Applying materials at this level will ONLY APPLY TO PARTS OF THE OBJECT 
THAT DON’T HAVE MATERIALS ALREADY APPLIED. That means that if you’ve 
applied materials to certain groups inside the model (via the Material node), those 
polygons will keep those materials.  

Internal Material Networks 
You can set up a /mat or /shop context INSIDE your geometry node. There are a lot of reasons 
why you’d want to do this, but the most important is that you want you bundle your materials 
and your models together if you’re working within a pipeline. 
 
To do so, simply create a Material Network node (or a Shader Network node) inside your 
geometry node. Once you do that, you can dive into that node and create materials, then 
reference those materials from your geometry… 
 



 
 

NOTE: Once you create an internal Material Network, it’ll be viewable as a section along 
with /mat in the Material Palette view aswell. 

UV Unwrap 
Attempts to generate UVs for the input. 
 



You can add/fix UVs in the network view. Drop a UV unwrap node and connect whateer 
geometry you want to it… 

 
 
You can choose how the UVs get applied… 

 
 

NOTE: To actually see the generated UVs, you can use the Scene view and switch your 
view from perspective to UV (shortcut is Space+5)… 

 
You can also switch to the geometry spreadsheet to see the UV attributes added to your 
points/vertices/faces/whatever. 

Color Nodes 
You can directly apply color(s) to geometry components without going through materials or 
shaders. When you do this, it mixes the color you select with whatever material/shader is being 
applied to your geometry. 
 



It’s fairly straight-forward what to do with a Color node. Go into your geometry node in the 
Network view and drop a Color node, then hook your geometry into it… 

 
 
In the parameters pane, choose the components which you want the color to apply to. You can 
do so by clicking the arrow on the right of the Group. 

 
 
The other parameters here should be straightforward. Class determines what component type 
to apply the geometry to (e.g. faces or points or edges or whatever). Color type can be set to 
Constant or Random (or a few others). Everything after that point will be dependent on what 
color type was set to. 
 

NOTE: If you go into the geometry spreadsheet, you can see the color show up under 
attributes for whatever component type you used for Class (Cd is the name of the 
attribute). 

 

Lights 
NOTE: This section was copied over from the main document. There’s nothing more 
worth adding here because this isn’t a renderer anyone uses for anything. 

 
Houdini (mantra) provides a bunch of lights that are very similar to Arnold and Maya lights… 

● Point Light → emits light equally in all directions 
● Area Light → a rectangle/disk/whatever that emits light 
● Geometry Light → similar to having a polygon mesh in Arnold that you set to emit light 



● Distant Light → parallel rays, as if the sun were shining 
● Environment Light → provide an HDR image and get light emitted based on that -- 

similar to mentalray’s image based lighting or Arnold’s skydome light 
● Sky Light → how is this different from the environment light above??? 

 
Add them to your scene and move them around just like any other scene node. You can find 
them in the Light shelf (2nd shelf set in the build desktop) or via the tab menu. 

 
 
An easy to position a light is through the scene view. You can make it so as if you’re looking 
through the light, and orient it as you move around your scene. To do this… 
 

1. Select the light in the camera dropdown on the top-right of the scene view (just below the 
top toolbar) 

2. Toggle the lock camera/light lock button on 
3. Orient your view around, just as normally would 
4. Toggle the lock camera/light lock button off 

 
 
 
Almost all lights come with many properties that are similar to Arnold. They probably work just 
like Arnold does. The properties panel has sections for increasing the light sampling (if stuff 
comes out too grainy) and setting intensity/exposure property and a bunch of other stuff. 
 
Intensity and exposure seem to be the main control properties here. Here’s the description of it 
from my Arnold notes… 
 
Intensity Intensity of your light. This works the same way as a regular Maya light. 

The higher your intensity is, the more light will be given off. 
 



Exposure Intensity of your light. This is different from the above setting in that it’s 
measured in f-stops (just like real photography). It’s designed to help you 
interact with real cinematographers. For example, the cinematographer 
may come and ask the artist to increase something by half a stop -- you 
can do that directly here in this setting.  
 
This is exponential… each time you go up by 1, it doubles the intensity of 
your light. 
 
NOTE: This is linked to the intensity in that the exposure uses the 
current intensity value as the basis for its setup. 
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Introduction 
VEX is a proprietary programming system that’s used for a bunch of different things within 
Houdini: shaders, deforming geometry, particle movements, etc.. 
 
Some facts about VEX… 

● VEX is inspired by RenderMan’s shading language 
● VEX has its own compiler (called vcc) 
● VEX can be “written” with nodes through VOPs (Vex OPerators) 
● Prior to VEX, Houdini provided a scripting system called Hscript  

 
This document will focus on using VEX through the VOPs interface in Houdini. That means that 
we’ll be programming by dragging-and-dropping nodes and connecting them up. We won’t 
writing programs in VEX. 
 
For more information on writing VEX, see the VEX language reference… 
http://www.sidefx.com/docs/houdini/vex/lang 
 

http://www.sidefx.com/docs/houdini/vex/lang


For more of an introduction on VEX/VOPs, see 
http://www.tokeru.com/cgwiki/index.php?title=Houdini_Vops&oldid=2317 

Create 
It looks like you can create VOP nodes in pretty much any context other than directly in /obj… 
 
In the network view, go to the Tab Menu and search for “VOP”. You’ll get a list of VOP node 
types that you can use. 
 
For example, if you go inside one of your geometry nodes and use the Tab Menu to search for 
VOP, here’s what you’d see… 

 
NOTE: You can also add in a node where you directly type in VEX script via the VEX 
node… 

 
 
Pretty much all the VOP nodes listed above either boil down to being Volume VOP or Attribute 
VOP. For example, if you choose Primitive VOP, you’ll actually get an Attribute VOP node but 
the Run Over property will automatically be set to Primitives. 

http://www.tokeru.com/cgwiki/index.php?title=Houdini_Vops&oldid=2317


 

 
NOTE: Remember that “primitive” is Houdini’s term for polygons/faces. 

 
In the case of Attribute VOP, the Run Over property defines what level of geometry that the VEX 
operations will be processing. Your VEX operations will update/add/delete attributes on that 
geometry based on however you defined your logic/operations. 
 
Remember that most of Houdini is about attributes being updated/added/deleted as they flow 
through the system. For example, if you’re working with points, your points may have an 
attribute called… 

● P → a vector that describes their location in space 
● N → a vector that describes their normal (if they have one) 
● Cd → a 3D vector used for RGB coloring (if they’re colored) 
● uv → a 2D vector that describes the UV coordinate for the point (if mapped to UV) 
● etc.. 

 
NOTE: See http://www.sidefx.com/docs/houdini/model/attributes for more common 
attributes 

 
In addition to these common attributes, you may have attributes that get used by solvers to do 
computations on the points (e.g. an attribute called v for velocity) or custom attributes that you 
add yourself (e.g. maybe the artists need attributes to do something or some other Houdini 
person will use them to do some additional calculations). 

Export 
You can export your Attribute VOP node as a Houdini Digital Asset by first putting it in its own 
Subnetwork and then exporting that subnetwork as a Houdini Digital Asset. 
 
See the Subnetwork section of the main Houdini document to see how to do this. 
 

http://www.sidefx.com/docs/houdini/model/attributes


NOTE: It looks like previous versions of Houdini let you do this straight from the VOP 
node (instead of having to create a subnetwork). The option seems to be missing now. 

Solve 
In certain cases, you will want the computation happening in your Attribute VOP node to make 
use of previous frame’s geometry. You can do this by putting your Attribute VOP inside of a 
Solver node… 

 

 
 
Inside of your Solver, you’ll have access to the previous frame’s geometry as well as any inputs 
you fed into the solver node. Simply feed your previous geometry and your current geometry 
into your VOP node and do whatever computations you need to... 

 

Inputs and Outputs 

Attributes 
By default, when you create an Attribute VOP node, you’ll get 2 nodes that will let you 
import/export common attributes... 



 
 
You can drop in a Bind node for any additional attributes that you want to import/export. Just 
make sure that you… 

1. set the Name property to the name of the attribute 
2. set the Type property to the correct type the attribute is set to 
3. set the Export property to When Input is Connected (the Bind node will gain an input) 

 

 

 
 

NOTE: Notice how we dropped 2 Bind nodes for the same attribute (named attrib in the 
example). If you have multiple Bind nodes pointing to the same attribute, you can only 
set the parameter on the first Bind node. All other Bind nodes for the attribute will copy 
those parameters. 



 
If you want to take the parameters from a Bind node that isn’t the first for the attribute, 
check the ‘Use This Node to Set Parameter Attributes’ checkbox. 
 
NOTE: If you set the attribute to one that’s already being imported/exported by the 2 
default nodes, your properties are going to be disabled. That’s because the 2 default 
nodes are internally doing the same thing to give you access to these attributes, and 
they already have the properties set. 

Parameters 
You can expose the inputs of a node my MMB as a Parameter on the Attribute VOP node that it 
sits in. 
 
To do this, begin by MMB clicking on the input and choosing Promote Parameter. When you do 
this, a little nubby will appear for that input… 

 →   
 
Double-click on the nub to expand out the hidden Parameter node. 

 



NOTE: If you want to turn this back into a nub, MMB click on the input and choose Hide 
Input Nodes... 

 
 
In the Parameter node, you can set the name of the parameter, the label that shows up for the 
parameter, the default value of the parameter, and the range of inputs for the parameter (will 
show up as a slider)... 

 
 
If you go back out to your Attribute VOP node, you’ll see your new parameter show up in the 
parameter window… 

 
 
You can re-organize your Attribute VOP node’s parameters via the Edit Parameter Interface. 
For more information on this, see the Subnetworks section in the main Houdini document. 
 



NOTE: We dealt with a basic parameter node, but you also have the option of using a 
Ramp Parameter node. A Ramp Parameter node makes in some input and changes it so 
that it fits some ramp property on your Attribute VOP node (it’ll show up as an actual 
ramp vs just a field). 

 
A couple of things to be aware of… 

1. the Ramp Type option should almost always be set to Spline Ramp. 
2. your input has to be normalized to be between 0 and 1 (I think you can use a Fit 

Range node to normalize to a 0 to 1 range before feeding in) 

Relative References 
You can make a relative reference to the node of any other parameter, even if it’s outside of the 
Attribute VOP node that you’re working in… 

 
 
In the example above, we’re going outside of our Attribute VOP node and instead accessing the 
tx parameter of a node called box1. This is perfectly legal to do. 
 
For more information on setting relative references, see the Parameter View section in the main 
Houdini document. 
 

NOTE: If you want to reference an attribute in the expression, you can do so by prefixing 
the attribute’s name with a @. See 
https://houdinitricks.com/quicktip-new-attribute-syntax-in-houdini-15/ 

Connections 
If the connect is a solid line, you’re fine. 
 

https://houdinitricks.com/quicktip-new-attribute-syntax-in-houdini-15/


If the connection shows up as a dotted line, it means that there’s some implicit conversion 
happening between the output and the input. For example, if the node you’re working with 
expects a float but you’re giving it a vector of floats, the line will show up as dotted… 

 
 
It’s best to explicitly convert the data to the type expected rather than relying on these implicit 
conversions. In the example above, we can convert our vector to a float using a Vector to Float 
node… 

 



Common Nodes 

Arithmetic/Aggregation 

 

Transform 
Important nodes here are Look At, Translate, Scale, Rotate 



 

Noise 
Import node here is Turbulent Noise. 

 
 
Make sure you look at the documentation for the noise before using it. If you’re feeding in 
positions, the output is the position offset -- you have to add the offset to the original value to get 
the final result… 



 

Conversions 

 

Utility 
Important nodes here are the ones used for comparison and fitting (shrinking down values to 
some range)… 

● Comparison: Switch, Compare 
● Fitting: Fit Range, Fit Range Unclamped 



 






